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PART 1. LEVEL OF INFORMATION SYSTEMS 
 

  Since  no  single  system  provides  all  the  information  an  organization  needs,  a 
number  of  systems  have  been  developed  to  serve  different  organizational  levels  and 
functions.  Operational,  knowledge,  management  and  strategic‐level  systems  are 
designed  to  meet  a  variety  of  different  information  needs.   Different  levels  in  an 
organization have different interests and needs 

 
Figure  1 

 
          Operational  level  systems  support  operational  managers  needs  for  current, 
accurate  and  easily  accessible  information  primarily  used  to  keep  track  of  the 
elementary activities and transactions of the organization. 

This practical guides try to complete Information Systems lecture with Practical 
Information Systems activity in busniess organizations. 

Every Operational level Information Systems (Figure 1) supports business functions, 
this practical guide contains  majority of practical Operational level with ofHice suites. 

Main contents of this guide, cosist of : 

1. Everydaya ofHice 
2. Administration 
3. Finance 
4. Human Resource, 5. Marketing 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PART 2.  EVERYDAY OFFICE 
 

1. Pricing a product to maximize revenue 
Determining  a  price  for  a  product  that maximizes  revenue  is  an  ongoing  process 

that  challenges  the  best  business  planners.  The  Hirst  step  in  developing  a  pricing 
strategy is to collect data about the buying habits of your customers. You can use that 
data to calculate a product's price elasticity of demand, which is a measure of how price 
changes affect consumers' willingness to buy a product. 
Pricing strategy plays a critical role in Hleshing out a company's budget. Pricing is used 
to project sales revenue and calculate proHit and loss. In addition, some pricing strategy 
tasks, such as collecting pricing data and positioning products in new markets, can be 
expensive. Budgets need to account for these costs as required line items. 
 
Collect pricing data 

The Hirst step in a pricing strategy is to collect data about how changing prices 
affect buying habits. You can initially sell your product in a limited number of markets 
to  get  a  feel  for  how  your  customers  react  to  the  product.  Sell  your  test  product  at 
slightly different prices in each market to determine the price that produces the most 
revenue. 
Another way  to  collect  pricing  data  is  to  compare  historical  sales  data  about  similar 
products your  company sells. Or you can purchase historical  sales data about  similar 
products sold by competitors. 
You can learn about buying habits by asking your customers directly. Conduct surveys 
to determine your customers' sensitivity to a product's price changes. 
 
Price elasticity of demand 

With  a  product's  pricing  data  in  hand,  you  can  calculate  price  elasticity  of 
demand, which is a ratio that measures how price variations affect customer purchases. 
In mathematical terms, price elasticity of demand is calculated as the percent change in 
product demand divided by the percent change in product price: 
Price Elasticity of Demand = % change in demand / % change in price 
To calculate the percent change in demand, Hind the difference between the quantities 
purchased at each price and divide the difference by the average of the two quantities: 
(Quantity2 – Quantity1) / ((Quantity1 + Quantity2)/2) 
To calculate the percent change  in price,  Hind the difference between the two product 
prices and divide the difference by the average of the two prices: 
(Price2 – Price1) / ((Price1 + Price2)/2) 
Sample calculation 
Follow  these  steps  to  calculate  the price  elasticity of demand when a product's price 
changes from $24 to $26, using Higures from the table below: 
Price Quantity purchased Total revenue 
 
Price 1  $24  45  $1,080 
Price 2  $26  43  $1,118 
 Calculate  the percent  change  in demand between Price 1  and Price 2  :  (43 – 45)  / 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((45 + 43) / 2) = –2 / 44 = —0.045 (or –4.5%)  
 Calculate the percent change in price between Price 1 and Price 2 : (26 – 24) / ((24 + 

26) / 2) = 2 / 25 = 0.08 (or 8%)  
 Divide the percent change in demand (result of step 1) by the percent change in price 

(result of step 2) to determine the price elasticity: –4.5 / 8 = –0.56  
The price elasticity of demand when the price increases from $24 to $26 is –0.56. 
 
Interpreting price elasticity of demand 

The Hirst thing you can do when interpreting the price elasticity of demand value 
is to ignore any negative signs. All you're concerned with is the size of the value. 
When the price elasticity of demand between two prices is equal to 1, the total revenue 
stays the same. This indicates that the price increase exactly offsets the lower number 
of sales. 
When  the price elasticity of demand between  two prices  is  less  than 1,  total  revenue 
goes up. This  shows  that  customers are not bothered by  the product's price  increase 
and continue to buy it at the new price. 
But  when  the  price  elasticity  of  demand  between  two  prices  is  greater  than  1,  total 
revenue goes down, indicating that customers do not buy enough of the product at the 
higher price to offset the price increase. 
Sample calculation 
As  an  example,  consider  the  data  for  a  product  sold  at  three  different  prices  in  the 
following table. 
Price Quantity purchased Total revenue Elasticity 
Price 1  $10  25  $250   
Price 2  $12.50  20  $250    1 
Price 3  $15  12  $180    2.75 
In this case, the price elasticity of demand between Price 1 and Price 2 is equal to 1. It 
doesn't matter whether the price of your merchandise  is $10 or $12.50 — consumers 
will  buy  enough  goods  at  the  higher  price  to  generate  the  same  amount  of  total 
revenue. 
The price elasticity of demand between Price 2 and Price 3 is 2.75. In this case, it does 
matter if you increase your product's price to $15. Fewer customers are willing to buy 
your product at that price, so your total revenue goes down signiHicantly. 
 
Factors affecting price elasticity of demand 

Calculating  a  product's  price  elasticity  of  demand  helps  you  plan  your  pricing 
strategy.  But  the  cold,  impersonal  math  used  to  calculate  price  elasticity  of  demand 
doesn't account for every element affecting the demand for your product. 
Here are  some other  factors  to  consider when you evaluate how price  changes affect 
product sales: 

a. Access  to  substitute products     Many customers don't  care which brand of 
laundry detergent they buy. They may choose a competitor's product if you 
raise your product's price. 

b. Item  cost  as  a  proportion  of  income      Understand  the  disposable  income 
level  of  your  customers.  The  demand  for  products  that  consume  a  larger 
proportion of a customer's budget will likely decrease as prices increase. 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c. Item necessity    Milk? Necessary. Bread? Necessary. Hand‐roasted premium 
coffee beans? A  luxury.  Increased prices  for  luxury products  tend  to  lessen 
demand. 

d. Duration of the price change    Reduced prices during a sales event can drive 
up demand in the short term, building valuable brand identity and word‐of‐
mouth advertising. 

e. Item attractiveness    Athletic shoes and some types of clothes are valued as 
status  symbols  in  some markets. These  items  command higher prices  than 
they would in markets where they are considered normal commodities. 

 
Monitor price elasticity of demand 

Finding a product's price elasticity of demand isn't something you can do once and 
forget about. You need to monitor your competitors' prices and sales continually so that 
you  can  re‐examine  your  pricing  strategy  to maximize  revenue.  And whenever  your 
pricing  strategy  changes,  make  sure  you  update  your  budget  to  reHlect  changes  in 
projected revenue, proHits and loss, and pricing strategy costs. 
 

f. Understanding cost behavior for effective budgeting 
Use Excel to separate Hixed and variable costs 
To help budget  future costs, you need  to separate your  Hixed costs and variable costs 
from a total cost formula. The formula for total costs can be expressed as: 
Total Costs = Fixed Costs + (Variable Cost per Unit × Cost Driver Activity) 
You can use  the  linear  regression  function  in Microsoft OfHice Excel 2007  to estimate 
these  Hixed  and  variable  costs  and  develop  your  cost  formula.  Linear  regression  is  a 
statistical  technique  that  Hits  a  line  to  a  set  of  data  points  to  show  the  relationship 
between two variables. One variable is a dependent variable. Its value is inHluenced by 
the second variable, known as the independent variable. 
When  there  is  close correlation between  two variables,  the  linear regression  tool can 
also  help  you  understand  how  costs will  change  for  a  given  forecasted  activity  level. 
Understanding this cost behavior will help you create a more accurate budget. 
Follow these steps to run the linear regression function in Excel: 
Step 1: Enter data and set up software 
a. Open a new worksheet in Excel. You can enter your own data on the worksheet or 

use the data in the example that follows. 
b. Create headings for the worksheet. For example, to evaluate the cost behavior of a 

manufacturing company, label columns Month , Total Production Costs , and Units 
of Output . 

c. In the Total Production Costs column, enter the costs you want to evaluate. Total 
production costs represent the dependent variable. 

d. In the Units of Output column, enter the expected cost driver of your production 
costs. Units of output represent the independent variable. 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Step 2: Run the linear regression function 
a. On the Tools menu, click Data Analysis . Click Regression , and then click OK . Note 

  If the Data Analysis command is not available, click Add‐Ins on the Tools menu, 
select the Analysis ToolPak check box, and then click OK . You may see a message 
asking  whether  you  want  to  install  the  ToolPak.  Click  Yes  and  follow  the 
instructions. During installation, you may be asked to insert the original disk that 
came with your Microsoft OfHice System software.   

1.  
b. In the Regression dialog box, make sure that the insertion point is in the Input Y 

Range  box,  and  then  in  your  worksheet,  highlight  the  Total  Production  Cost 
column, including the column heading. 

c. Place your insertion point in the Input X Range box, and then in your worksheet, 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highlight the Units of Output column, including the column heading. 
d. Select the Labels check box. 
e. Under Output options  , click New Worksheet Ply: and type Regression Output in 

the text box. 
f. Under  Residuals  ,  select  the  Line  Fit  Plots  check  box,  and  click  OK  to  run  the 

regression analysis.  

 
g. Your new worksheet with the linear regression output should look something like 

the following: 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Note   To adjust column widths to see the entire regression output, select a column. On 
the  Format menu,  point  to  Column  ,  and  then  click  AutoFit  Selection  .  If  the  scatter 
graph appears small, click the chart. Place your cursor on a corner of the chart and drag 
to enlarge the chart. 
 
Step 3: Interpret the Regression Output 
In the linear regression output, the Intercept coefHicient is your estimate of Hixed costs. 
The Units of Output coefHicient is your variable costs per unit. 

 
The  accuracy  of  these  Hixed  and  variable  cost  estimates  depends  on  the  relationship 
between  your  production  costs  variable  and  units  of  output  variable.  In  general,  a 
strong  correlation  between  the  two  variables  results  in  a more  accurate  estimate  of 
future costs. 
Using  the  linear  regression output,  you have  a  few ways  to  evaluate  the  relationship 
between your variables: 
 R  Square  value     In  the  Regression  Statistics  box  in  the  regression  output,  the  R 

Square  value  indicates  how  much  of  the  variation  in  the  dependent  variable 
(Production  Costs)  can  be  explained  by  the  independent  variable  (Units  of 
Output). In this case, the R Square value is 0.9544, meaning that 95.44% of the 
dependent variable variation can be explained by the independent variable. This 
shows a strong correlation between the two variables.  
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 Scatter  graph     The  scatter  graph  in  the  output  data  is  a  statistical  diagram  that 

shows the regression line along with the data points. If the data points are close 
to the regression line, there is a good correlation between the independent and 
dependent variables (the R Square value mentioned earlier gives a quantitative 
measure  of  this  correlation).  If  the  regression  line  and  data  points  appear  far 
apart, there is a poor correlation between your two variables, and you may need 
to Hind another independent variable or conduct additional analysis.  

  
 Residuals    The residuals in the Residual Output section show how each data point 

differs from the predicted point of the regression line. The smaller the residual 
value, the better your prediction. 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You may want to refer to a basic statistics book to learn more about linear regression 
and how to interpret the output, because there are many nuances. 
 
Step 4: Use your regression output to help with budgeting activities 

Assuming you have a  strong correlation between your  two variables, you now 
have enough  information  to estimate your  future costs. To continue  the example of a 
manufacturing  company,  the  formula  for  total  production  costs  can  be  expressed  as 
follows: 

o Total  Production  Costs  =  Fixed  Costs  +  (Variable  Costs  per  Unit  ×  Cost 
Driver Activity) 

o Use  the  rounded values of  the  Intercept  coefHicient  ($12,320)  and  the Units of 
Output  coefHicient  ($20.96)  from  the  regression  output  to  estimate  your  cost 
behavior: 

o Total Production Costs = $12,320 + ($20.96 × Cost Driver Activity) 
o This  formula  can now be used  to  estimate  future  costs  during  your budgeting 

process.  For  example,  let's  say  that  you  expect  to  produce  2,500  units  next 
month. This number is your cost driver activity. Your expected production costs 
would be as follows: 

o Total Production Costs = $12,320 + ($20.96 × 2,500) = $64,720 
o Use the linear regression function in Excel to help you better segregate Hixed and 

variable  costs.  This  Excel  feature  helps  you  develop  an  understanding  of  cost 
behavior and predict accurate future costs for budgeting and planning purposes. 

2. Information Management 
 

A  database  is  a  collection  of  information  that's  related  to  a  particular  subject  or 
purpose,  such  as  tracking  customer  orders  or maintaining  a music  collection.  If  your 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database  isn't  stored  on  a  computer,  or  only  parts  of  it  are,  you  may  be  tracking 
information  from  a  variety  of  sources  that  you're  having  to  coordinate  and  organize 
yourself. 
For  example,  suppose  the  phone  numbers  of  your  suppliers  are  stored  in  various 
locations: in a card Hile containing supplier phone numbers, in product information Hiles 
in  a  Hile  cabinet,  and  in  a  spreadsheet  containing  order  information.  If  a  supplier's 
phone number changes, you might have to update that information in all three places. 
In a database, however, you only have  to update  that  information  in one place — the 
supplier's phone number is automatically updated wherever you use it in the database. 
 
Access database [iles 
Using Microsoft  Access,  you  can manage  all  your  information  from  a  single  database 
Hile. Within the Hile, you can use: 
1. Tables to store your data. 
2. Queries to Hind and retrieve just the data you want. 
3. Forms to view, add, and update data in tables. 
4. Reports to analyze or print data in a speciHic layout. 
5. Data  access  pages  to  view,  update,  or  analyze  the  database's  data  from  the 

Internet or an intranet. 

 
1. Store data once in one table, but view it from multiple locations. When you update 

the data, it's automatically updated everywhere it appears. 
2.  Display data in a query 
3.  Display data in a form 
4.  Display data in a report 
5.  Display data in a data access page 

 
Tables and relationships 
  To store your data, create one table  for each type of  information that you track. To 
bring  the  data  from multiple  tables  together  in  a  query,  form,  report,  or  data  access 
page, deHine relationships between the tables. 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1. Customer  information  that  once  existed  in  a  mailing  list  now  resides  in  the 

Customers table. 
2.  Order information that once existed in a spreadsheet now resides in the Orders 

table. 
3.  A unique ID, such as a Customer ID, distinguishes one record from another within 

a  table.  By  adding  one  table's  unique  ID  Hield  to  another  table  and  deHining  a 
relationship, Microsoft Access can match related records from both tables so that 
you can bring them together in a form, report, or query. 

 
Queries 
To Hind and retrieve just the data that meets conditions that you specify, including data 
from multiple tables, create a query. A query can also update or delete multiple records 
at the same time, and perform predeHined or custom calculations on your data. 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1. This  query  accesses  separate  tables  to  retrieve  the  Order  ID,  Required  Date, 

Company  Name,  and  City  information  for  customers  in  London  whose  orders 
were required in April. 

 
Forms 
  To  easily  view,  enter,  and  change data directly  in  a  table,  create  a  form. When you 
open a form, Microsoft Access retrieves the data from one or more tables, and displays 
it on the screen with the layout you choose in the Form Wizard, or with the layout that 
you created on your own in Design view  (Design view: A window that shows the design 
of these database objects: tables, queries, forms, reports, macros, and data access pages. 
In Design view, you can create new database objects and modify the design of existing 
ones.) . 

 
1. A table displays many records at  the same time, but you might have to scroll  to 

see all of the data in a single record. Also, when viewing a table, you can't update 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data from more than one table at the same time. 
2. A form focuses on one record at a time, and it can display Hields from more than 

one table. It can also display pictures and other objects. 
3. A  form  can  contain  a  button  that  prints,  opens  other  objects,  or  otherwise 

automates tasks. 
 
Reports 
To analyze your data or present it a certain way in print, create a report. For example, 
you might print one report  that groups data and calculates  totals, and another report 
with different data formatted for printing mailing labels. 
 

 
 
1. Use a report to create mailing labels. 
2.  Use a report to show totals in a chart. 
3.  Use a report to calculate totals. 

 
Data access pages 
To make  data  available  on  the  Internet  or  an  intranet  for  interactive  reporting,  data 
entry, or data analysis, use a data access page. Microsoft Access retrieves the data from 
one or more  tables and displays  it on  the  screen with  the  layout  that you created on 
your own in Design view, or with the layout you chose in the Page Wizard. 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1. Click the expand indicator .. 
2.  .. to display the data and record navigation toolbar for the next level of detail. 
3.  Use the record navigation toolbars to move to, sort, and Hilter records, and to get 

Help. 
 

3. Presenting with PowerPoint: 10 dos and don'ts 
 

1. Hold up your end with compelling material. 
 In a way, PowerPoint's ease of use may be its own worst enemy. However 
simple and engaging it can be to build eye catching slides and graphics, bear in 
mind that PowerPoint isn't autonomous. The audience has come to hear you, not 
merely to stare at images tossed onto a screen. Build a strong PowerPoint program, 
but make sure that your spoken remarks are no less compelling. "PowerPoint 
doesn't give presentations — PowerPoint makes slides," says Matt Thornhill, 
president of Audience First, a Midlothian, Va., business that offers presentation 
training. "Remember that you are creating slides to support a spoken presentation." 
 

2. Keep it simple. 
 We've all likely seen PowerPoint and other presentations where the speaker 
seemed ready to propose to the program. After all, it was clear that he fell in love 
with every wrinkle, special effect and other bit of gadgetry available. But the most 
effective PowerPoint presentations are simple — charts that are easy to understand, 
and graphics that reflect what the speaker is saying. Some authorities suggest no 
more than five words per line and no more than five lines per individual slide. "Don't 
gum up the works with too many words and graphics," Kerr says. "Do you really 
need to have everything up on the screen?" 
 

3. Minimize numbers in slides. 
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 PowerPoint's lure is the capacity to convey ideas and support a speaker's 
remarks in a concise manner. That's hard to do through a haze of numbers and 
statistics. For the most part, most effective PowerPoint displays don't overwhelm 
viewers with too many figures and numbers. Instead, leave those for a later, more 
thorough digestion in handouts distributed at presentation's end. If you want to 
emphasize a statistic in PowerPoint, consider using a graphic or image to convey the 
point. "For instance, when I once was talking about the prevalence of Alzheimer's 
patients, I used a photograph of an old woman rather than just throwing up a 
number on the screen," Kerr says. 
 

4. Don't parrot PowerPoint. 
 One of the most prevalent and damaging habits of PowerPoint users is to 
simply read the visual presentation to the audience. Not only is that redundant — 
short of using the clicker, why are you even there? — but it makes even the most 
visually appealing presentation boring to the bone. PowerPoint works best with 
spoken remarks that augment and discuss, rather than mimic, what's on the screen. 
"Even with PowerPoint, you've got to make eye contact with your audience," says 
Roberta Prescott of The Prescott Group, a Connecticut-based communications 
consulting firm. "Those people didn't come to see the back of your head." 
 

5. Time your remarks. 
 Another potential land mine is a speaker's comments that coincide precisely 
with the appearance of a fresh PowerPoint slide. That merely splits your audience's 
attention. A well-orchestrated PowerPoint program brings up a new slide, gives the 
audience a chance to read and digest it, then follows up with remarks that broaden 
and amplify what's on the screen. "It's an issue of timing," Kerr says. "Never talk on 
top of your slides." 
 

6. Give it a rest. 
 Again, PowerPoint is most effective as a visual accompaniment to the spoken 
word. Experienced PowerPoint users aren't bashful about letting the screen go blank 
on occasion. Not only can that give your audience a visual break, it's also effective 
to focus attention on more verbally-focused give and take, such as a group 
discussion or question and answer session. 
 

7. Use vibrant colors. 
 A striking contrast between words, graphics and the background can be very 
effective in conveying both a message and emotion. 
 

8. Import other images and graphics. 
 Don't limit your presentation to what PowerPoint offers. Use outside images 
and graphics for variety and visual appeal, including video. "I often have one or two 
very short video clips in my presentations," says New York technology consultant 
Ramon Ray. "It helps with humor, conveys a message and loosens up the crowd." 
 

9. Distribute handouts at the end — not during the presentation. 
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 Some people may disagree with me here. But no speaker wants to be chatting 
to a crowd that's busy reading a summation of her remarks. Unless it is imperative 
that people follow a handout while you're presenting, wait until you're done to 
distribute them. 
 

10. Edit ruthlessly before presenting. 
 Never lose the perspective of the audience. Once you're finished drafting your 
PowerPoint slides, assume you're just one of the folks listening to your remarks as 
you review them. If something is unappealing, distracting or confusing, edit 
ruthlessly. Chances are good your overall presentation will be the better for it. 
  
4. About creating presentations 
 
 Creating a presentation in Microsoft PowerPoint involves starting with a basic 
design; adding new slides and content; choosing layouts  (layout: The arrangement 
of elements, such as title and subtitle text, lists, pictures, tables, charts, 
AutoShapes, and movies, on a chart.) ; modifying slide design, if you want, by 
changing the color scheme  (color scheme: A set of eight balanced colors that you 
can apply to slides, notes pages, or audience handouts. A color scheme consists of a 
background color, a color for lines and text, and six other colors selected to make 
slides easy to read.) or applying different design templates  (design template: A file 
that contains the styles in a presentation, including the type and size of bullets and 
fonts; placeholder sizes and positions; background design and fill color schemes; 
and a slide master and optional title master.) ; and creating effects such as 
animated slide transitions. The information below focuses on the options available 
to you when you start the process. 

The New Presentation task pane  (task pane: A window within an Office 
application that provides commonly used commands. Its location and small size 
allow you to use these commands while still working on your files.) in PowerPoint 
gives you a range of ways with which to start creating a presentation. These 
include: 

 • Blank     Start with slides that have minimal design and no color applied to 
them. 

 • Existing presentation    Base your new presentation on one that you have 
already written and designed. This command creates a copy of an existing 
presentation so you can make the design or content changes you want for 
the new presentation. 

 • Design template    Base your presentation on a PowerPoint template that 
already has a design concept, fonts, and color scheme. In addition to the 
templates that come with PowerPoint, you can use one you created yourself. 

 • Templates with suggested content    Use the AutoContent Wizard to 
apply a design template that includes suggestions for text on your slides. You 
then type the text that you want. 
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 • A template on a Web site    Create a presentation using a template 
located on a Web site. 

 • A template on Microsoft.com    Choose from additional PowerPoint 
templates in the Microsoft Office Template Gallery. These are arranged 
according to type of presentation. 

 
12 Tips for Creating Better Presentation 
 

1. You have a presentation to create. It's important. But, formatting diagrams 
can take forever and the text on your slides seems to have a mind of its own. 
Then, there's the sad fact that everybody's PowerPoint presentations look the 
same. 

 
2. Sound about right? If so, I've got good news for you! Creating professional, 

unique presentations can be much easier than you might think. 
 

3. This article will help you find the right tools to get exactly the presentation 
you want. We'll look at three components of creating effective presentations, 
and provide timesaving tips to help send your presentation off in style. 

 
4. Clearly Communicate Your Information 

 
5. Want slides that clearly communicate your most important points? You might 

be surprised at how little work it takes to go from basic to brilliant! 
PowerPoint provides a host of tools for keeping your slides consistent, 
precise, and professional. 

 
6. Take a look at two versions of a basic bulleted text slide below. The text in 

both slides is identical. Which would you prefer to present? 
 

7. It took just a couple of shapes and a bit of editing in the Slide Master to go 
from the slide on the left to the slide on the right. 

 
8. Here are 4 ways to let Microsoft Office PowerPoint 2003 help you clearly 

communicate your information: 
 

a. Set up and use AutoLayouts. In PowerPoint 2003, you can select from 
over two dozen available layouts with a single click. Just open the Slide 
Layout task pane to view and access layouts for text and a variety of 
content. To open this task pane, on the Format menu click Slide Layout . 

b. You can also customize the positioning and appearance of all layouts at 
once, using the Slide Master. On the Slide Master, make a variety of 
formatting changes just once to affect all slides in your presentation. 

 
c. To access the Slide Master, on the View menu select Master and then 

click Slide Master . Once in Slide Master view, you can reformat the font, 
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bullets, and even the line spacing of text. (These options are all available 
in the Format menu.) Or, alter the size and positioning of AutoLayout 
areas—the areas of the master that control slide layouts for the active 
presentation. 

 
d. Turn off (or manage) AutoCorrect layout options. PowerPoint 2003 

provides several automatic formatting options to help your slides conform 
to the provided layouts. They can be big timesavers, but they can also be 
frustrating if you're not using them intentionally. If you don't want your 
bulleted text to shrink automatically in order to fit content, or the 
positioning of pasted objects to change automatically, you can easily turn 
off these features. 

To turn off any AutoFormat options, on the Tools menu click AutoCorrect 
Options . Then, select the AutoFormat As You Type tab of that dialog box. 

 
 
The bottom three options on the AutoFormat As You Type tab of the AutoCorrect 
dialog box control automatic formatting behavior for layouts. 
 

9. Start by outlining your presentation in Word. Take time to outline your 
presentation before creating slides. Doing so can save time and help you give 
a more clear and effective presentation. 

10. Try setting up your outline in Word, using paragraph styles Heading 1 
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through Heading 9. When you use those styles for your outline, you can 
create PowerPoint slides in just a click. 

 
11. Consider differences for print vs. screen presentations. Presentations 

designed to be viewed on screen don't always work well when you print 
them. Dark backgrounds that look good on slides, for example, rarely print 
well. Similarly, footer content that you need in print is likely to be distracting 
on-screen. Fortunately, PowerPoint makes it easy to switch between print 
and screen presentation designs. Here are two features that can help: 

o PowerPoint provides color schemes that apply to different slide 
elements (such as text, lines, and object fills). You can format slides 
for print using one color scheme, then just click to apply a different 
scheme for on-screen use. All slide elements formatted with scheme 
colors will automatically swap to take on the new scheme. 

o Showing, hiding, and customizing header and footer content in 
PowerPoint can be a snap. 

o Grab the Viewer's Attention 
 

The Microsoft Office Clip Art gallery offers a huge range of images. These can 
be great for many uses, but they might not be the most sophisticated way to 
emphasize your important idea. 
 
Creating slides that get the viewer's attention is not about which pictures to 
include. It's about using the space on your slides effectively. Don't crowd 
your slides, and only include elements that contribute to the points you want 
to make. When you use graphics on a slide, choose images that serve a 
purpose (such as a chart or diagram that displays a direct benefit of your 
idea). Compare the two marketing slides below, for example. 
 

12. The simple column chart in the slide on the right replaces two paragraphs of 
text, and makes a much stronger impression. Coordinating the chart colors 
with the slide design was automatic. 

 
Check out 4 ways to help grab and keep your viewer's attention. 
 

1. Use sound recordings when sending a presentation electronically. A clean 
slide that emphasizes key points is more effective than a slide that contains 
every word you intend to say. But, what do you do if you're sending your 
presentation electronically? Consider recording narration to accompany your 
slides. 
o To record narration for a presentation, on the Slide Show menu click 

Record Narration . 
o To record sound for a single slide, on the Insert menu select Movies and 

Sounds and then click Record Sounds . 
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2. Use Notes and Handouts to help you stay on track or to create quick and 
easy leave-behinds for your viewers. Use the Notes pane that appears below 
the slide in Normal view to write notes to yourself for your presentation, or to 
create notes that you can print for your viewers. You can also format and 
print handouts that contain up to nine slides per page. 
 

3. Create charts and diagrams that emphasize your key points. To chart data in 
PowerPoint, start by clicking the Insert Chart icon on any Content slide 
layout, as show here: 

 
The Insert Chart icon is circled in red. 

 
o When you click the Insert Chart icon, you'll get a default chart that's a 

snap to customize and a data worksheet that's easy to edit. 
o The Insert Diagram or Organization Chart tool (available from the 

Drawing toolbar) is a nice way to create quick and easy flowcharts. 
However, I find that using AutoShapes to create any type of diagram or 
flowchart can provide much more flexibility without much more work. See 
the section of this article below for information on the available tools for 
creating flawless presentation graphics. 

4. Use animation and slide transitions consistently and sparingly. Having text 
and graphics appear on-screen just when you need them can be a nice 
touch. However, using too much animation can distract from your 
presentation's content. 
o For effects that emphasize without overwhelming, limit animation to key 

points and use consistent animation choices throughout the presentation. 
Open the Custom Animation task pane (available on the Slide Show 
menu) to apply and manage animation. 

o Subtle and consistent slide transitions can also provide a professional 
touch without being distracting. Use the Slide Transition task pane 
(available from the Slide Show menu) to format and apply slide 
transitions. Learn about using slide transitions and timings. Stay in Control 
of Your Presentations 

 
Custom colors, layouts, and graphics can do a lot for your presentation. But a 
misaligned flowchart, or a presentation that crashes on your client's computer, isn't 
likely to make the impression you want. For example, take a look at the two 
organization chart images below. Which would you prefer to call your own? 
 
Nudging and fussing to create the organization chart on the left took about an hour, 
and it's far from perfect. Using available PowerPoint tools for duplicating and 
alignment, the chart on the right took just 10 minutes to create. 
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Here are 4 ways to keep your presentations both great-looking and easy-to-
manage. 
 

1. Keep file size manageable. A common cause of stress with PowerPoint 
presentations is that the file size becomes too large to edit or to run 
presentation smoothly. Fortunately, this problem is easy to avoid by using 
smaller picture file types, compressing pictures, and using native PowerPoint 
features whenever possible (such as tables, charts, and AutoShapes) instead 
of embedding and importing objects. 

 
2. Use the available tools for creating perfect diagrams. One of the nicest things 

about PowerPoint is that getting something perfect is easier than getting it 
close. 
o Instead of nudging objects until your eyes get tired, use the Align Or 

Distribute tools. They can help you perfectly align and evenly distribute 
objects in a click. To access these tools, select Align or Distribute from the 
Draw menu, which is available on the Drawing toolbar. 

 
o You can also use Guides to align and space objects. Guides can help you 

measure distance and keep positioning of elements consistent across 
multiple slides. To see your Guides, on the View Menu select Grid and 
Guides . Then, in the Grid and Guides dialog box, select Display drawing 
guides on screen. 

o Zooming in on an object in PowerPoint can greatly increase the accuracy 
of what you see. To do this without trial and error, just select the object 
before changing the Zoom setting on the Standard toolbar. 

  
3. Know exactly what the recipient of your presentation will see. If you're 

sending a presentation by e-mail, try saving the presentation as a Slide Show 
so that it automatically opens for the recipient in slide show view. To do this, 
on the File menu click Save As . In the Save As dialog box, select PowerPoint 
Show (.pps) from the Save As Type dropdown list, as you see here: 

 
This screenshot shows how to use save your presentation as a slide show. 
 

If you're sending a presentation on CD, the Package for CD feature in 
PowerPoint 2003/2007 is a great time and stress-saver. This feature will set up your 
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presentation (including linked files) on a CD so that the slide show will run correctly 
for any recipient. It even adds a PowerPoint viewer so that the recipient's computer 
doesn't need PowerPoint to run the show. 
 
5. Using Template to Create Presentations 
 

• Use Masters for consistency and to save time. In addition to customizing 
elements of slide layouts (as discussed earlier in this article), you can use the 
masters to save time and keep slides consistent by adding graphics and 
formatting just once for all slides. 

• Place graphics (such as your logo) on the Slide Master, so that they 
automatically appear on all slides. Note that, when graphics appear on the 
master, you can still hide them for just certain slides. To hide graphics for an 
active or selected slide, on the Format menu click Background . Then, in the 
Background dialog box, select Omit background graphics from master . 

• You can add a Title Master to use different formatting and graphics on title 
slides from other slides in your presentation. To do this, switch to Slide 
Master View . Then, select New Title Master from the Insert menu. 

• While a great new feature in PowerPoint enables you to create multiple slide 
masters for a single presentation, use this feature carefully. Keep in mind 
that the purpose of a master is to help keep your slides consistent 

 
About design templates 

Microsoft PowerPoint provides design templates  (design template: A file that 
contains the styles in a presentation, including the type and size of bullets and 
fonts; placeholder sizes and positions; background design and fill color schemes; 
and a slide master and optional title master.) that you can apply to a presentation 
to give it a fully designed, professional look. 

  

PowerPoint design templates 

Using the Slide Design task pane  (task pane: A window within an Office 
application that provides commonly used commands. Its location and small size 
allow you to use these commands while still working on your files.) , you can 
preview and apply a design template to your presentation. The template can be 
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applied to all slides or selected slides, and you can apply more than one type of 
design template in a single presentation. 

Whenever you apply a design template, a slide master  (slide master: The 
slide that stores information about the design template applied, including font 
styles, placeholder sizes and positions, background design, and color schemes.) for 
that template is added to your presentation. If you apply a different template to all 
your slides, the old slide master is replaced by the master in the new template. 

You can save any presentation you've created as a new design template, and it will 
be available in the Slide Design task pane. 

Other types of templates 

Content templates     A content template  (content template: A design template 
that also contains text suggestions on each slide. You replace the text suggestions 
with the text that you want. A content template contains a slide master and an 
optional title master.) has all the elements of a design template plus a suggested 
outline for the presentation. You apply a content template when you first create a 
presentation, through the AutoContent Wizard . 

  

One slide in a content template with suggestions for bullet points 

You can create your own content templates and add them to the AutoContent 
Wizard . 

Templates from Web sites     Your team might always use a template that's 
stored on a Web site. You can access such files from within PowerPoint. 

Templates on Microsoft.com     Choose from additional PowerPoint templates 
available from Microsoft Office Online in the Templates area of Microsoft Office 
Template Gallery. The templates are arranged according to type of presentation. 

￼ 

6. Planning Corporate Meetings 
 

6 Ways to Work More Effectively on a Virtual Team 

Who hasn't awakened a colleague from a deep sleep with a mistimed telephone 
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query, wished for a quick in-person chat to resolve a sticky problem with a co-
worker who's forever on the move, or didn't know where to find a critical file owned 
by someone half a world away? 

These and other problems are commonplace for those who work on teams in other 
parts of the city, country, or the world. Frequent travel—exhausting and 
expensive—can't be the day-to-day solution. 

So, while you've probably solved the time zone problem by checking the Web for 
local time before you make a call, the following suggestions might help solve some 
of the other problems of working with others a world away. 

On This Page 

1. Use Instant Messaging for Quick Impromptu Meetings 
2. Use a Virtual Conference Room for More Formal Meetings 
3. Keep Your Meetings Organized 
4. Set Up a Virtual Water Cooler 
5. Review Edits of Co-Workers, No Matter Where They Are 
6. Stay in Touch: Use a PDA to Keep Your Important Data With You 

 
1. Use Instant Messaging for Quick Impromptu Meetings 

One tool that's often overlooked when working with virtual teams and remote co-
workers is instant messaging (IM). It's a great tool for a quick answer or opinion. 
Once you add your teammates to your contact list, the IM program, such as 
Windows Messenger or MSN Messenger, will let you know when they're online. You 
can also message a team member's cell phone, such as the Microsoft Windows 
Mobile-based Smartphone. 

Most programs also allow a multi-person chat, making instant messages a great way 
to conduct a spontaneous meeting. Unlike e-mail, everyone sees the messages and 
can respond simultaneously—even "talking" all at once—adding a touch of closeness 
for far-flung team members. Some of these programs also enable you and your 
team to exchange files, use a whiteboard—even see each other if you each have a 
Webcam. 

What you need to get going:   Everyone can download either Windows 
Messenger or MSN Messenger , both Microsoft products. The one downside of 
instant messaging is that it often only works if everyone is using the same program 
and system. 

2. Use a Virtual Conference Room for More Formal Meetings 

Web-based conferencing makes it possible to brainstorm, make a slide presentation, 
have a staff meeting, or conduct training sessions with a group of people who are 
thousands of miles apart. Everyone attending sees the same information at the 
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same time, as if they were gathered around one table. These programs, such as 
Microsoft Office Live Meeting, also enable you to share files (not just prepared 
slides), use digital whiteboards—even save the presentation so people who couldn't 
attend the meeting can watch it later. Most services charge on a monthly or per 
user/per minute basis. 

 
 
1. Green boxes indicate who is attending the meeting.   
2. You can make notes using a digital whiteboard.   
3. Your agenda goes here. 
 
What you need to get going:   With Live Meeting you just need a telephone 
and a PC with a Web connection. Get more information about Microsoft Office Live 
Meeting . 

3. Keep Your Meetings Organized 

 What's the agenda for today's meeting, and where are the documents you 
need to review? What did you decide at last week's meeting? There's an alternative 
to scrambling through e-mail messages, attachments, and your file system to find 
the answers—a Meeting Workspace provides a central place on the Web for all this 
information. It's easy to set up: you create the site within an Outlook meeting 
request. 

 Then, before a meeting, use it to send a meeting invitation to those attending 
and include a link to the workspace where those invited can see the agenda and 
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find the documents you plan to discuss. Conduct the meeting as you would 
ordinarily whether in person, over the phone, or using a conferencing program, such 
as Live Meeting. Then use a Meeting Workspace to publish the meeting results and 
track tasks. 

What you need to get going:   Everyone on the team needs Microsoft Office 
Outlook 2003, a Microsoft Exchange Server e-mail account, and access to a 
SharePoint Services site. Talk to your IT administrator to find out what your 
company has set up. Get the details on how to use and set up a Meeting Workspace 
. 

4. Set Up a Virtual Water Cooler 

 Set up a Web site for everyone on your team to share information such as 
calendars, to-do lists, and reports, as well as poll team members on an upcoming 
decision or hold newsgroup-style discussions. With a Windows SharePoint Services 
site, you can control access to team documents, keeping track of versions and 
updates. As teammates add or delete documents, links are automatically updated so 
the content is always current. You can also personalize the display of information to 
a certain extent—for example, hide information that doesn't interest you or change 
the order in which the information is listed. 

What you need to get going: Everyone on the team needs to have access to a 
SharePoint Services site. Get more detail on the benefits of using a SharePoint site 
or take advantage of the free trial version . 

Note   You can also set up a SharePoint site (and the Meeting Workspace 
mentioned above) using Microsoft Office SharePoint Portal Server 

5. Review Edits of Co-Workers, No Matter Where They Are 

 When you can't pore over a document together, the ability to track the 
changes you and your teammates make is a boon to collaboration. Microsoft Office 
Word, Microsoft Office Excel, and Microsoft Office PowerPoint all enable you to track 
the changes you make, although the capabilities in Word are the most powerful. 

You can also accept or reject proposed changes, and when it's time to distribute the 
document, you can set Word to hide all revisions. For a more final version, you can 
accept all the changes to make sure that no stray revision marks or comments 
remain in the document you plan to distribute. 
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1. Word automatically color-codes the edits and comments of each person. (You can 
display the comments of any one reviewer or all reviewers.)  2. Word tags edits with 
the reviewer's initials as well as the date and time of each change. 

What you need to get going:   Learn how to track changes in Word with three 
self-paced lessons and two hands-on practice sessions. When you're done, take 
away a Quick Reference Card to help you work on your own. You can also find out 
how to track changes in Excel and track changes in PowerPoint . 

6. Stay in Touch: Use a PDA to Keep Your Important Data With You 

 One challenge to long-distance collaboration is making sure you have on hand 
all the documents you need to contribute to a conference call or online meeting. 
This is even more difficult when you're away from your desk. Consider solving part 
of the problem with a mobile device such as a Smartphone or a Pocket PC. You can 
easily keep information on your mobile device synchronized with your desktop or 
notebook computer so you always have the latest information with you. Read more 
about Windows mobile devices . 

What you need to get going:   Browse the devices available on Windows 
Mobile and talk with your IT department about their recommendations. If you use a 
Windows Mobile-based device, you'll have all you need to keep your computer and 
mobile device in sync. However, you may want to take advantage of the latest 
version of ActiveSync , the software that makes synchronization possible. 
 
7. Collaborate with confidence 
 
 Working together as a team is crucial to success in the workplace, and good 
teamwork doesn't happen by accident. Coordinating the efforts of many people 
takes planning and foresight. This is as true for collaborating on documents as it is 
for any other aspect of teamwork. 

Collaborating on documents 
 Document collaboration is a fact of life in today's workplace. For example, to 
create a new employee manual, a human resources manager might need input from 
the legal department, a vice president, and department managers. The manager 
might also need to have an administrative assistant send the finished product 
through the revision process. 
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In another example, a lawyer gathering information for a bankruptcy estate filing 
might need information from government agencies, creditors, and the client. The 
documents must be reviewed by the appropriate people, and then the filing must be 
prepared, documented, and filed. 

The pitfalls 
If you work with other people on documents, you probably see what can go wrong 
in the process. For example: 

o   Multiple versions of a document floating around, creating redundancy and 
extra work. 

o  Confusion about task ownership. For example, one team member might 
waste time researching an issue that another has already covered. 

o   Overlooked comments and input when a document is passed around. 
o  Wasted time compiling comments from multiple copies of a document. 

Some collaboration options 
To solve these problems and bring efficiency to your projects, you have several 
collaboration methods to consider: 

 • Hard copy (paper documents)    In spite of hopes about a "paperless 
workplace," most of us rely on paper documents at some point. It's 
straightforward enough — you give the document to a team member who 
marks it up or attaches comments and passes it on. No software training is 
required, and if you stick to one copy or file folder, it should be easy to keep 
everyone's comments together. On the other hand, paper documents can get 
misplaced. They're not convenient if only some of the team members work in 
the same office and if team members can't see comments as the comments 
are added.  

 • E-mail messages or attachments    When you need quick feedback, 
an e-mail message is one way to go. E-mail gets most people's attention, and 
they can reply just to you or to the entire group. If you want input on a 
longer or more formal document, you can send a Microsoft Office Word 2003 
document as an attachment. If you use the tracking and reviewing features 
in Word, you can see who made which changes and when they were made. 

 • The Meeting Workspace feature in Microsoft Office Outlook® 
2003    Meeting Workspace provides a convenient, centralized place where 
your team can work together on a project. It's also a great place to store 
everything that pertains to a project. You can post meeting agendas and 
minutes, record decisions, track tasks, and more. You always have the latest 
version, and you don't have to send large files through e-mail. 

 
Improving the process 
How can you improve the quality and efficiency of your team's document 
collaboration method? Here are some lessons that people have learned — 
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sometimes the hard way. 

Periodically evaluate your collaboration process 
It pays to step back and evaluate your current collaboration process. What's going 
right? What needs improvement? 

For example, on your last project: 

o  Did team members participate in the process? 
o  Were conflicts or differences of opinion resolved satisfactorily? 
o  Did one person end up doing all the work? 

You might want to ask your co-workers what types of problems the group had with 
document collaboration. Analyzing a problem that seems like a fluke, such as 
someone revising a document from the wrong folder, can help you find process 
steps that can be improved to prevent the same problem next time. Teamwork 
doesn't get better because people grit their teeth and try harder — teamwork 
improves when better processes are put into place. 

Designate a project leader 

Every project or document needs an owner. Otherwise, the document might not 
accomplish its objective. For example, someone posts a spreadsheet on an intranet 
site and everyone is instructed to keep it up to date. Two months later, only a few 
people are entering information, and a month after that, even they aren't sure 
whether they're supposed to. Because the document has no owner, they don't even 
know who to ask. 

Make it clear who owns each document or project. A hard copy (paper document) 
or a Word file can have a heading that identifies its owner. If you use the Meeting 
Workspace feature in Outlook 2003, you can identify the owner in the document 
library. (A document library is a folder where a collection of files is shared and the 
files often use the same template. Each file in a library is associated with user-
defined information that is displayed in the content listing for that library.) 

Let people know what's expected of them — and when 

The first thing that the leader needs to do is get commitment from the group. If you 
send an assignment — even with a specified deadline — don't assume it's become 
anyone's priority unless they've confirmed it. Team members might be facing a killer 
deadline that puts your document low on the priority list. When you establish and 
confirm expectations and a deadline, you're much more likely to get timely input. 

Hard copy or an attached Word file can have a heading with roles, expectations, 
and deadlines. A Meeting Workspace keeps all this information in one place and 
always accessible to everyone on the team. 
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Stay on top of version control 

If you ever spent hours revising the wrong document, you know the frustration — 
and waste — that poor version control can lead to. And there are a lot of 
opportunities for ending up with the wrong file. Before you pass a file around, set 
some ground rules. 

For example, if you're sharing a document through e-mail, set rules for how to use 
the To line and the Cc line, and make sure everyone on the team understands 
when to use Reply or Reply to All . 

If you're passing around a Word document, protect the document from 
unauthorized changes and from having the Track Changes feature turned off. You 
can also require everyone who reviews or changes a document to add their name, 
the date, and a version number to a header or footer in the document. 

Version control is one of the strongest arguments for storing documents online. 
When you store a document in a Meeting Workspace, everyone on the team can 
always see the latest version. Any team member can check it out, make changes, 
and check it back in. You can see who has it checked out and who's made changes, 
plus you can look at the document history and see old versions at any time. 

Learn to resolve conflict 

As they say, if two or more people always agree, somebody's fibbing. Entire books 
have been written about reaching consensus, but a few basic rules can help. 

Management must set the standard for how conflicts are handled. Sometimes one 
person can be the tie-breaker; in other cases, the group can vote. In all cases, 
subject matter experts such as editors and legal counsel need to have the last word 
in their areas. 

 • Encourage communication and participation    Heavy-handed methods 
can help you reach a so-called consensus quickly, but they defeat the 
purpose of a team — using the diverse skill sets and backgrounds of team 
members. Make sure that your conflict resolution methods encourage 
communication and participation, not artificial consensus. 

 • Acknowledge opinions and share reasoning    For example, if you 
send hard copy around for comments, someone — usually the owner of the 
document or project — must compile the results. Depending on the project, 
this person might need to respond to each concern and comment, or they 
might be able to make the call without further input. Even when the 
document owner has the authority to make the final decisions, however, it's 
important to understand everyone's concerns and document how decisions 
were made. 

 • Keep a record of the project progress    If you use e-mail to do your 
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collaboration, you can send messages (with or without attached documents) 
back and forth until all issues are resolved. You can save the e-mail string as 
a record of the decisions that were made along the way. Comments and 
changes within the document also leave a good record of everyone's input. 
Be sure to save a copy with the comments and changes as a record, and 
then remove all tracked changes and comments before you publish the 
document. Meeting Workspace gives you a place to keep a collection of 
documents, plus other information such as background research, prior 
versions of documents, team member names and contact information, and 
notices about upcoming meetings.  

Keep your process flexible 

Not everything can be resolved effectively within a document — whether it be in 
hard copy, in an e-mail message, or posted online. Sometimes, you have to pick up 
the phone, walk down the hall, or schedule a meeting. 

Reaping the rewards 

By combining the strengths of individuals, your team working together can 
accomplish more than any of you could on your own. By combining personal and 
organizational skills with the right technology, you can effectively collaborate on 
documents and reap the rewards of successful teamwork. 

8. Communicate better using Meeting Workspaces 

When you're faced with the challenge of managing multiple projects and tasks, 
team meetings can help you be more productive both as a communicator and as a 
leader. But efficient, productive team meetings don't happen by accident. 
Organizing a meeting is a lot like organizing a project: You need the right people 
and processes in place to make it successful. 

Because meetings are instrumental in getting team members on the same page and 
encouraging decision making, you want to make the most of them. If you're serious 
about creating a meeting environment in which the participants are well-informed, 
deliverables are assigned, and progress is communicated, consider using the 
Meeting Workspaces feature in Microsoft Office Outlook® 2003. 

What is a Meeting Workspace? 

A Meeting Workspace is a unique type of Web site created using Microsoft 
Windows® SharePoint™ Services in collaboration with Outlook. You don't actually 
run the meeting in the workspace, rather you create a workspace to organize and 
communicate the contents of a meeting. A workspace can contain agendas, meeting 
notes, relevant documents, and the names and contact information for all 
participants. A workspace also enables you to store important information in a 
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central location so that you can track deliverables and decisions, keep your own 
team up to date, and maintain a record of the meeting that everyone involved in the 
project can refer to. 

For details about how Meeting Workspaces can help you to improve communication 
within the project team, see the Office Online article called About Meeting 
Workspaces. 

Requirements 

The Meeting Workspace feature in Outlook requires the following: 

 • Outlook 2007. 
 • A Microsoft Exchange Server e-mail account. 
 • Access rights to a parent Windows SharePoint Services site or a Microsoft 

Office SharePoint Portal Server Web site under which the Meeting Workspace 
will be a subsite. 

For more information about these requirements, contact your organization's 
administrator. 

Leading team meetings just got easier 

Before you schedule a meeting, consider the following practices for setting it up: 

 • Determine whether a sit-down meeting is the best way to communicate, 
deliver, or decide on the information. 

 • If appropriate, secure a meeting room. 
 • Establish when to meet and for how long. 
 • Decide who should participate in the meeting. 
 • Prepare a detailed meeting agenda, if required. 
 • Determine in advance what the goals of the meeting are. 
 • Decide which action items need to be assigned in the meeting. 
 • Plan for you or one of the other participants to take notes. 
 
When you have assembled this information, create a meeting request in Outlook. 
For example, to start a meeting request, open the Outlook Calendar, and then click 
Meeting Request on the New toolbar menu. 
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Enter the required information (attendees, meeting room, and time) in the meeting 
request, but before sending it out, click Meeting Workspace to create a shared, 
centralized site for the project team. In the Meeting Workspace pane on the 
right, click Create 
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Next, add any information or documentation you want your team to have access to 
through this site, and then send the meeting request. Each recipient of the meeting 
request will receive an invitation to view the Meeting Workspace you created for this 
meeting. 

 
 
For detailed information about creating Meeting Workspaces, see the Office Online 
article called Keep it together with a Meeting Workspace in the See Also section of 
this article. 

Let Meeting Workspaces help carry the weight 

When the meeting is over, the real work usually begins. Use your Meeting 
Workspace to help you relay the decisions that were made in the meeting and the 
milestones each team member must meet. For example: 

 • Create the meeting notes, and upload them to the Meeting Workspace for 
this meeting. 

 • Follow up with team members who have action items from the meeting. 
 • Communicate specific results to the participants. 
 • Store and share documents on the workspace site so that other team 

members can access the relevant information. 
 • Make project announcements. 
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 • Store future meeting summaries. 
If necessary, remind the meeting attendees of the Meeting Workspace location. 
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PART 3. ADMINISTRATION 
 

1. Equipment Inventory List 

 
 
2. Set up a new desktop computer 
 
Adapted from Ed Bott's Your New PC: Seven Easy Steps to Help You 
Get Started! 
When you set up a new desktop computer, some assembly is required. And 
computer setup isn't limited to hardware — when you first turn on a new computer 
that has Microsoft Windows preinstalled, you need to perform some simple setup 
tasks.  Follow these steps to set up a new desktop computer: 
 • Connect the hardware. 
 • Run Windows Setup. 
If the new computer is a standard desktop model, it consists of at least four pieces: 
a central processing unit (CPU), which is the box that contains the computer's 
processor, memory, disk drives, and ports for connecting external devices; a 
monitor; a keyboard; and a mouse. There might also be a pair of external speakers. 
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Turn the CPU around. The back of the CPU has a collection of ports and jacks that 
looks something like this illustration, although they might be arranged differently. 
 

 
o No.1: Keyboard and mouse. 
o No.2:  Parallel. 
o No.3:  Serial 
o No.4: Speaker/microphone 
o No. 5: IEEE 1394 (FireWire) 
o No. 6: Network jack 
o No. 7: USB 
o No. 8: Display adapter 

 
To connect the computer hardware, follow these steps: 

1.   Connect the keyboard and mouse. If the connector on the cord that is 
attached to the keyboard or mouse is round, plug the cord into a matching 
port on the back of the computer, like the keyboard and mouse ports shown 
in the illustration. If the connector on the cord is flat, plug it into any 
available USB port, like those shown at bottom right in the illustration. Both 
types of connectors are designed so that you can't plug them in the wrong 
way. 

2. Tip. If the computer uses a cordless mouse or cordless keyboard, follow the 
manufacturer's instructions to connect it to the computer. 

3. Attach the monitor to the display adapter. Most monitors use a standard 
analog cable with a 15-pin connector that plugs into a matching port. Some 
specialized monitors use digital connectors, which require a matching digital 
display adapter and a custom cable. 

4. Connect the speakers to the computer's audio output. The connector for 
stereo speakers is typically color-coded lime green. If the computer comes 
with a surround sound system, check the computer manual to find out where 
to plug in the center and back speakers. If the speaker cables have 
connectors that don't match the ports on the CPU, you might need to buy an 
adapter cable. 

5. Connect the CPU to an AC power source. Look for the thick power cord that 
comes with your computer. Plug the female end into the power supply on the 
back of the computer (not shown in the illustration), and plug the male end 
into a wall socket. If there is a surge protector or an uninterruptible power 
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supply connected to the AC power source, plug the CPU power cord into that 
power source instead. 

6. Connect the monitor to an AC power source. Press the power switch on the 
monitor to turn it on. 

7. Press the power switch on the front of the computer. Soon after the 
computer turns on, a series of status messages appears on the monitor, the 
last of which is the Windows desktop or the Windows logon screen. 

 
You're now ready to perform some simple Windows Setup tasks. 

Run Windows Setup 
The first time you turn on the computer, you must run Windows Setup. You can't 
skip this step, but you can go through it pretty quickly. Each screen asks you a 
question or allows you to select an option. The exact sequence of questions may 
vary, depending on how the computer maker assembled your computer.  

Here's a list of what you can expect to accomplish as you complete Windows Setup: 

 • Accept the End-User License Agreement (EULA). This legal 
agreement between the computer user, the computer maker, and Microsoft 
sets forth the user's legal rights to use the software. If you're setting up this 
computer for another user, you can accept the EULA without reading it. 

 • Enter the computer user's name and company name 
 • Choose region, language, and keyboard settings.The region and 

language settings tell Windows what language you want it to use for menus 
and dialog boxes. You can also specify whether the keyboard is not for use in 
the United States. Western European keyboards, for instance, offer keys and 
combinations that you can use to type accented characters more easily. If 
you're in the United States, you most likely want to accept the defaults. 

 • Select a time zone.Scroll through the list, and find the closest major city 
that's in your time zone. If your part of the world does not observe daylight 
saving time, make sure the Automatically adjust clock for daylight saving 
changes check box is clear. 

 • Give the computer a name.The name that you type here is what other 
users see when you share your files or printers with them over a network. 
When naming the computer, don't use the user name; if you do, Windows 
may get confused later if you try to set up a network. If you don't feel 
creative, Windows creates a random computer name for you. 

 • Activate and/or register the computer's copy of Windows with 
Microsoft. This step is optional, but it is very helpful if you plan to set up 
Internet access. 

 • Set up a user account By default, Windows XP creates an account called 
Administrator (or Owner, if you're using Windows XP Home Edition). The 
purpose of this account, as you might guess from the name, is to perform 
administrative tasks. Set up an account by entering the computer user's first 
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name. 
When you complete Windows Setup, click Finish. The computer restarts. On the 
Welcome screen, click the name of the user account that you just created to 
continue to the Windows desktop. 
 
3. Set up user accounts 

 
Adapted from Ed Bott's Your New PC: Seven Easy Steps to Help You Get 
Started! 
 
In some offices, more than one person uses the same computer. Every person who 
uses a computer should have a unique user account that is accessed with a private 
password. Each computer user can then view private files and e-mail, or personalize 
the desktop with favorite colors and photos. Of course, the best reason to set up 
individual user accounts is security. 
 
As an administrative assistant, you might have the job of setting up user accounts 
on a computer. This task might include establishing an account for yourself on that 
computer so that you can install new software or perform other administrative 
tasks. Follow these steps to set up user accounts and create passwords on a 
computer. 
 
Create a user account 
You can use Microsoft Windows XP to set up two types of accounts: 
 
 • Computer administrator This account gives the user full rights and privileges 

on the computer. The user can install programs, manage files and folders, 
create new accounts, or change existing ones. If you regularly need to 
perform software upgrades or other administrative chores on a computer, 
you probably want to create this type of account for yourself. 

 • Limited This account permits a user to run programs that are already 
installed on the computer and to make some changes to a personal user 
account. But the user can't install new programs, access files belonging to 
other users, or change other user accounts. 

 
Here's how to create a new user account:  
 1. Click Start, and then click Control Panel. 
 2. Double-click User Accounts. 
 3. In the User Accounts dialog box, click Create a new account.  
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 4.  Enter a name for the new user. After the user logs on, this name appears on 

the Welcome screen and at the top of the Start menu. Click Next to 
continue.    

 
 5. To choose the account type, select either Computer administrator or Limited.  
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 6. Click Create Account. 
Return to the User Accounts dialog box, where you can repeat these steps to create 

additional accounts for other users. 
 
Add a password to a user account 
Without a password, a user account remains unprotected. Anyone who sits at a 
computer can click a user name on the Welcome screen to log on to the account. 
The person can then start working with existing programs, installing new ones, or 
creating, changing, or deleting files. 
 
No matter how much you trust the people around you, creating a password for an 
account noticeably increases security. Using passwords also lessens the chance of a 
user accidentally logging on to the wrong account and mistakenly altering another 
user's files or settings. 
 
A password doesn't have to be complicated. Ideally, it should be at least seven 
characters long, with a mix of capital and lowercase letters and numbers. It should 
be easy for you to remember and hard for someone else to guess — that means no 
using your pet's name or your birthday! 
 
To create a new password, follow these steps: 
 1. Click Start, and then click Control Panel. 
 2. Double-click User Accounts, and then click Change an account. 
 3. Click your account name. 
 4. Click Create Password.  
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 5. Under the Create a password for your account heading, type the new 

password in both boxes. (Typing the password twice is a security precaution 
that prevents you from accidentally mistyping your intended password and 
being unable to access your account later.) 

 6. If you want to add a hint to remind yourself of the password, you can enter a 
word or phrase in the box at the bottom. This hint is available from the 
Welcome screen if you forget your password. Because anyone can see the 
password hint, make it something that jogs your memory but doesn't help 
someone who is trying to break in to your computer.   

 
 7. Click Create Password. 
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 8. At this point, Windows offers you the option of making your files private so 
that only you can read them. Choosing an option returns you to the User 
Accounts dialog box.  

 
 9. Click Start, and then click Log Off. Return to the Welcome screen, click the 

user name, and enter the new password to verify that it works. 
By creating a user account and password, you can ward off accidental or deliberate 
damage to a computer user's files and settings. 
 
4. Create a password reset disk 
 
Adapted from Ed Bott's Your New PC: Seven Easy Steps to Help You Get 
Started! 
As an administrative assistant, do you find it difficult to keep track of the many 
passwords that you need to access the computers in your office? Do employees 
come to you for help when they forget a password? Prepare for a forgotten 
password with this easy solution: create a password reset disk.  The password reset 
disk is an indispensable tool that stores a copy of a password in an encrypted 
format that no one can read. If you're unable to enter the correct password at the 
Welcome screen, you can insert the disk and create a new password.  Storing a 
password To store a copy of your password, you need a floppy disk or a USB flash 
memory key drive. Insert the disk into the drive or plug the key drive into a USB 
port, and then follow these steps:  
 1. Click Start, click Control Panel, and then double-click User Accounts. 
 2. In the User Accounts dialog box, click the name of your account. 
 3. In the left side of the What do you want to change about your 

account? box, under the Related Tasks heading, click Prevent a 
forgotten password. This starts the Forgotten Password Wizard. 
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 4. Read the introductory page of the Forgotten Password Wizard, and then click 
Next. 

  
 6. On the Create a Password Reset Disk page, select the drive — floppy disk 

or flash memory keydrive — where you want to save the password reset 
files. 

 7. On the Current User Account Password page, enter your current 
password, and then click Next. 

 8. The next two pages of the Forgotten Password Wizard provide progress 
indicators. When the Progress bar reaches 100% complete, click Next, and 
then click Finish. 

 9. After completing the wizard, remove the disk, label it clearly, and store it in a 
secure place. 

Using the password reset disk 
If you ever forget your password, you can log on to the computer by using a new 
password that you create using the Password Reset Wizard and your password reset 
disk. Follow these steps:  
 1. Click in the box on the Welcome screen where you normally type your 

password, and then press ENTER. 
 2. Click Use your password reset disk to start the Password Reset Wizard. 

Click Next.  
 3. Insert the password reset disk — place a floppy disk into a disk drive or 

connect a flash memory keydrive to a USB port.  
 4. Type a new password in the Type a new password box. Then type the same 

password in the Type the password again to confirm box.  
 5. In the Type a new password hint box, type one or two words to remind 

you of your password if you forget the new password. Remember to use a 
hint that spurs your memory but that won't help another user access the 
computer.   
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 6. Click Next, and then click Finish to close the Password Reset Wizard.  

  
 7. At the Welcome screen, log on to the computer by typing your new 

password in the Type your password box. 
The password reset disk is a handy tool for when your memory fails. But 
remember — other people can use the password reset disk to gain access to 
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your computer, so make sure that you store the disk in a secure place. 
 
5. OFFICE MANAGER 

 
1. Managing Employees Prevent Employee Turnover 
 
By Laura Stack, contributing editor for APOM 
The problem of employee turnover According to a 2007 workplace survey by 
CIGNA Behavioral Health called "Worried at Work: Mood and Mindsets in the 
American Workplace," workers are stressed to epidemic proportions. Forty-four 
percent of employees surveyed said their jobs were more stressful today than a 
year ago. As a result, 45% said they've either considered leaving their jobs in the 
last year, have left a job, or plan to do so soon.  Turnover can be extremely costly 
to an organization. For each employee you lose, the turnover costs range from 
120% to 200% of annual salary. On average, new employee performance takes 
13.5 months to reach maximum efficiency.  The causes of turnover Many people 
mistakenly believe that employees leave jobs primarily for better wages, benefits, or 
both. The cause is more likely to be one of the following: 

 • Understaffing 
 • Lack of communication 
 • Poor job fit  
 
Understaffing Employees who survived layoffs and recessions with their jobs 
intact are working harder than ever. The reduced number of workers still shoulder 
the same (or larger) total workload that existed before staff-cuts. In 2002, worker 
productivity in the United States was at its highest level since the 1950s — 4.7%. 
 
When productivity is high, organizations don't need to hire as many people. But it's 
hard for employees to be happy when, no matter how hard they work, they never 
catch up. 
 
Most professionals have a backlog of 200 or more hours of uncompleted work, in 
spite of working harder. As a result, employees experience a strong need to balance 
the urgent demands of work and personal life without sacrificing either. 
 
Lack of communication In focus groups, employees identified leadership's failure 
to provide a clear picture of the company's direction as a major reason for leaving a 
company. If you want to achieve better results and improve morale, clearly 
communicate where the company is going and why. 
 
Employees want to know your vision and what, specifically, you want them to 
accomplish. Employees also want to know how you think they're doing — and not 
just during annual reviews. Regular and consistent feedback is essential for your 
workers to do the job you expect. 
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Poor job fit Many employees feel unfulfilled, bored, or "stuck" in their current 
positions. Cross-training gives employees more variety and managers more flexibility 
in the workforce. Adjusting job tasks can also increase worker satisfaction. 
 
For example, UPS had a high turnover of drivers, a key position for the company. In 
talking with the drivers, UPS discovered that they hated to load their trucks but 
enjoyed the driving. So UPS designed a job classification of loading the delivery 
trucks, which cut turnover dramatically, because drivers no longer had to load 
trucks. 
 
Strategies to prevent employee turnover 
Preventing turnover is cost effective. It's cheaper to retain the employees you 
already have than to hire new ones — even a few. Here are some employee-
retention strategies: 
 • Recognize your impact as a manager 
 • Implement effective work/life programs 
 • Provide personal productivity training 
 • Adjust or establish constructive Human Resources policies. 
Recognize your impact as a manager People don't really quit companies, they 
quit managers. Many people leave simply because of the way they are treated every 
day. Surveys show that lack of appreciation, lack of teamwork, and the perception 
that the company doesn't care about employees are consistently the highest-rated 
reasons for low job satisfaction.  
As an office manager, you must specifically communicate to employees that you 
appreciate their contributions, rather than talking to them only when they do 
something wrong. Use charts and graphs distributed through electronic bulletin 
boards and e-mail groups to keep your team informed of results and how they are 
moving toward company goals. 
 
Implement effective work/life programs More and more organizations are 
looking to work/life programs to help employees cope with workplace stress. Many 
of Fortune's "100 Best Companies to Work for in America" cite work/life programs 
as one of their top tools to attract and retain the best employees and give their 
companies a competitive edge. 
 
Corning, for example, estimates that it saves $2 million a year because of increased 
employee retention attributed to career and family initiatives. Aetna estimates that it 
saves $1 million a year because of its policy allowing employees to return to work 
part-time after family leaves. NationsBank (which merged with Bank of America in 
1998) reported that two-thirds of its employees on flexible schedules would have 
left the company if flex-time had not been an option. Several studies have found 
that on-site childcare centers decrease turnover. 
 
Provide personal productivity training Through proper productivity training, 
many people who work a 50–hour week can achieve those same results in 40 hours. 
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You create mutual value for the company and employees when you: 
 • Identify key employees, whose production rate and results are superior. 
 • Help employees learn to achieve the same results in less time through 

productivity training. 
 • Let employees leave the office earlier and get home to their lives. 
 • Improve employee morale and job satisfaction to increase retention. 
 • Both sides benefit from this win-win productivity proposition. 
 
Employers: 
 • Achieve the results they need without pushing employees over the edge.  
 • Become an employer of choice.  
 • Reduce staff turnover. 
Employees: 
 • Achieve more results in less time. 
 • Balance work and personal lives. 
 • Experience less stress.  
Adjust or establish constructive Human Resources policies The methods 
described below can be technical and often have legal ramifications, so you should 
consult with HR and legal resources before implementing these policies. 
 • Salary-level caps  
 • Structure pay levels by job categories so that long-term employees don't 

price themselves out of their jobs. Properly structured salary-level caps 
prevent this situation because the salary for a given job will never be higher 
than the job is worth. 

 • Phased-in benefit plans  Establish retirement plans that aren't fully vested 
until employees have many years on the job. This encourages people to stay. 
For example, an employee is 25% vested after two years, 50% after five 
years, and 100% after 10 years. Also award additional vacation time for each 
year an employee is with the company.  

 • Performance-based salary increases  Create performance-planning and 
review programs that help you retain desirable employees. Frequent reviews 
and positive reinforcement reward and encourage high-performing 
employees. Poorer performers can be identified and assisted, then rewarded 
when they improve. 

 
Solving the problem 
Analyze your office with an eye toward the reasons behind high turnover: 
understaffing, communication problems, and poor job fit. Then put appropriate 
retention programs in place to address these issues. Good management techniques, 
open communication, feedback, positive reinforcement, work/life programs, time 
management training, and creative personnel policies all support employee 
retention. 
 
Face the facts: You are renting talent, not buying the hearts and souls of workers. 
When your workers are more satisfied with the balance of their work and life, you 
gain company loyalty and retain desirable employees. You save money and training 
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time and improve your own job performance and satisfaction for a win-win situation 
all around. 
 
About the author Laura Stack, MBA, CSP (Certified Speaking Professional), is a 
contributing editor for OfficeOurs, the magazine of the Association of Professional 
Office Managers (APOM). Stack is an expert on employee productivity and the 
author of Leave the Office Earlier (Broadway Books, 2004). For further information 
about Laura Stack, visit her Web site at www.TheProductivityPro.com. 
 
 
Employee Orientation Template MS Power Point 
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Make employee Information Form 
 

 
 
 

Employee Information 
Personal Information 

Full Name:    
 Last First M.I. 

Address:   
 Street Address Apartment/Unit # 

    
 City State ZIP Code 

Home Phone: (         ) Alternate Phone: (         ) 

E-mail Address:  

Social Security Number or Government ID:  

Birth Date:  Marital Status:  

Spouse’s Name:  

Spouse’s Employer:  Spouse’s Work Phone: (         ) 
 
Job Information 

Title:  Employee ID:  

Supervisor:  Department:  

Work Location:  E-mail Address:  

Work Phone: (         ) Cell Phone: (         ) 

Start Date:  Salary: $ 
 
Emergency Contact Information 

Full Name:    
 Last First M.I. 

Address:   
 Street Address Apartment/Unit # 

    
 City State ZIP Code 

Primary Phone: Relationship:  (         ) 

 
Company Name 
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PART 3. FINANCE 
 
 

1. Prepare financial statements 
 
The books are closed and all account balances are reconciled. You're justifiably 
proud of the resulting financial statements, and you're comfortable that every 
number is accurate. Will someone outside your company get a favorable impression 
from reviewing these documents? 

Who reads your financial statements? 

Obviously, your company managers read the financial statements carefully and do 
further analysis on the numbers included. They were most likely the audience you 
had in mind as you prepared the statements. 

But it's important for you to step back and see the financial statements in the way 
that a person outside the company might see them. To do this, you must first 
understand who these outsiders are and why they would be interested in your 
financial statements. There are several categories of outsiders. 

Investors 

 • Goal    Decide whether and at what price to commit, or continue to commit, 
resources to your company. 

 • Potential gain    A share in future profits. 
 • Risk    Loss of their own money and loss of investment income from a better 

investment. 
 

Creditors 

 • Goal    Decide whether your company can pay back current or future debt, 
either from expected future income or from the sale of assets. 

 • Potential gain    Fees for lending resources. 
 • Risk    Loss of their own money and loss of investment income from a better 

investment. 
Customers 

 • Goal    Decide whether your company can meet their needs for product 
delivery. Understand the value of their business to your company and review 
the price that they are paying. 

 • Potential gain    The growth of their own business. 
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 • Risk    Dependency on you could cause their company to fail. 
 

Suppliers 

 • Goal    Decide whether to sell their product to you. Understand the value of 
their product to your company and review the price that they are charging. 

 • Potential gain    Income for their own business. 
 • Risk    Loss of income from you and loss of income from a better customer. 
 

Auditors 

 • Goal    Decide whether to provide a favorable opinion on both the accuracy 
of the numbers and the ongoing viability of your company. 

 • Potential gain    Fees for rendering opinion and enhanced professional 
reputation. 

 • Risk    Damage to reputation and potential lawsuits if opinion proves 
incorrect. 

 

Industry analysts and fund managers 

 • Goal    Decide whether to endorse your company as a good investment for 
their customers. 

 • Potential gain    Enhanced reputation, new customers, and higher 
commissions. 

 • Risk    Loss of reputation and customers. 
 

Government regulators 

 • Goal    Determine whether your statements comply with the regulations for 
companies that sell their stock publicly. 

 • Potential gain    The gain is on your side: You are allowed to continue to 
market your stock. 

 • Risk    The risk is also yours: Failure to comply means denial of trading and, 
potentially, stiff penalties. 

Although some of these outsiders have access to you or other members of company 
management and can ask questions to help fill in the blanks in their analysis, other 
readers have to make conclusions by using only the information in the statements. 

What are they looking for? 

As you can see, there are many different reasons that outsiders might read your 
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financial statements. Some of the answers that these readers seek are available 
directly from the statements, but finding other answers might require additional 
effort. 

Analysis methods depend on a reader's goals, approach to financial analysis, and 
personal preferences, as well as your company's various businesses and 
circumstances. There are, however, some common tasks that outsiders perform, 
including: 

 • Looking for changes over time and trends in those changes. The easiest way 
to accomplish this goal is to lay side by side the financial statements for 
consecutive periods. (Remember that a set of financial statements is a 
snapshot in time — only by comparing several snapshots do you get a true 
picture of where the numbers are heading.) 

 • Comparing some line items as percentages of others. For example, outsiders 
might look at general and administrative expenses as a percent of sales to 
determine whether your operations are becoming more efficient as 
production grows. Or they might look at accounts receivable as a percent of 
total assets to see if you are paying attention to the income collection side of 
the business. 

 • Evaluating your company's trends against others in your industry. Readers 
calculate standard ratios to measure return on investment, safety and 
liquidity, and operating efficiency, and then compare your ratios to your 
competitors'. If there's a significant difference, they try to determine the 
reason. 

How many financial statements will be included in this comparison process? That 
depends on your company's business and circumstances. In most cases, a 10-year 
period is good. However, recent changes in the company or the industry may make 
this historical data less helpful. 

What are readers looking for on each financial statement? 

Balance sheet 

How liquid is the company? Liquid assets are cash and other assets that can be 
quickly and easily converted into cash. 

How well is the company set up to meet cash needs? For payments required in the 
next year, this question is answered by determining liquidity. For longer-term 
obligations, the outsider needs to know when payments are due. 

How much are your key assets really worth? Fixed assets are included in your 
balance sheet at cost and not market value. In some businesses, the value of the 
company is based on the value of a few key assets. Outsiders need to know the 
information that helps them value these assets. 
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How thin is your remaining equity? The equity section of the balance sheet shows 
how much remains of earlier investments in your company. Operating losses and 
distributions may have depleted this investment. The remaining equity is the 
funding your company could use for further expansion. 

Income statement 

Since your income statement shows a net profit, you were certain that anyone 
reading the statements would come away with a favorable impression. You now 
understand that the outsider is not looking at the income statement for this period 
alone. 

Can the income from this period be compared with the income reported in earlier 
periods? Income can be thought of as a combination of revenue and other gains. 

 • Revenue is the income from your operations. It's the money you collect from 
the delivery or manufacture of a product or from providing a service. 

 • Other gains are inflows from sources other than operations, such as capital 
gains and losses. 

Be sure to clearly separate these two income categories on your income statement. 

Also state separately any unusual income amounts from operations included this 
period. For example, you might have charged your existing customers a one-time 
license fee. 

Are there different business segments in your company? For example, you might 
have two very different products. Outsiders want to see income and expenses 
broken out by segment, particularly if there are differences in net profit or in 
potential for growth between these products. 

Statement of cash flow 

How many dollars have to be invested to get a dollar of revenue? The cash flow 
statement describes the company's sources of cash and uses of cash. These 
numbers detail how the company reconciles its beginning and ending cash balance. 

Other information in financial statement package 

There are other, more general pieces of information that outsiders want to see, 
such as: 

 • Certainty level for all measurements. If you reported some income that has 
not yet been collected, how certain are you that the amount you booked will 
be collected? 

 • Known or expected changes that will affect future performance. These could 
be changes in your industry, changes in market conditions, or changes within 
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your company. 
 • Information to build a management report card. How close are these results 

to projections? 
 

Can you make your financial statements better? 

Having viewed the data through an outsider's lens, you may find that your 
confidence in your financial statements has turned to concern. What can you do 
now? 

It's too late to make changes that can immediately affect the profitability of your 
business. Obviously, you can't go back and "cook the books." But you can use the 
information that you just gained to correct any operational shortcomings in the next 
business cycle. 

And you can still enhance your financial statements package. Do the analysis 
described above. Sit down with a representative of each reader category and watch 
them analyze your financials. Note questions they ask. 

There's also a good chance that you can add information that, if read at the same 
time as the financial data, could lessen readers' concerns. For example, you can: 

 • Provide detail on segments of your business. 
 • Clearly separate operating income and expense items from other sales and 

related expenses. 
 • Because these statements will be reviewed side by side with earlier 

statements, make sure that you categorize items consistently. 
 • Separate the effect of unusual and nonrecurring income and expense items 

from recurring items. 
You can add these details by inserting line items in the statements or by including 
notes with the statements. 

Also, consider adding supplementary investment analysis information to your 
financial statements package. You will have the opportunity to provide this package 
as a presentation to outsiders. You may present it directly, post it on your Web site, 
or mail it. 

Think of your financial statement package as part of your company's public image. 
The outsiders who read the package are key to your continued success. Be as 
concerned with addressing their needs as you are with taking care of your 
company's customers. 

 
Auditor 
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2. CREATING BUSINESS PLAN 
Every business plan is a unique document because each plan details the 

specifics of one business. Yet your plan should share themes and an organizational 
format that are common to other business plans. This will help investors and other 
important readers to quickly understand your business idea and locate sections of 
interest. 
This isn't a document you dash off. Most plans require two or three months of 
researching, analyzing, and writing (and reviewing and refining and rewriting). It 
can take up to 300 hours — or, in some cases, up to a year — to get the plan right. 
Business plans generally run 20 to 30 pages, but they can range from 10 to 50 
pages or more. The length depends on your preferences and the plan itself. But 
keep in mind that you're likely to be a more passionate reader than most. Put 
yourself in the shoes of your other readers. What do they need to know? What can 
be left for a later discussion or report after you've engaged their interest? 
Plan organization 
You must cover all the elements of the business and its strategies for growth and 
success. The following sections are generally included in a business plan: 
Cover page 
This includes your company name and contact information. 
Executive summary 
This is probably the most important section of your plan. In two pages or less, it 
should sum up: 

o What your business will do. 
o What your market opportunities will be. 
o How you will make money. 

Most readers start with the summary and then, if they're interested, go on to other 
sections. You'd be smart to write this section last, after you've thought through and 
written everything else. It will be a lot easier then. 
Industry environment 
Step back and think about what first sparked your enthusiasm to start this business. 
You must set it up so that someone who has no notion of your field or industry will 
understand why you're jumping in. 
This section should also include: 

o A description of any significant trends, industry innovations, or big players in 
the market. 

o A summary of the current state of your industry and its future. This is a 
positioning overview that covers the market's driving forces as well as current 
and future opportunities. You're creating a map so that you can show where 
your idea fits in and why your company fills a gap or a need. 

o Details of your business's target customers as well as your strengths in the 
marketplace. 

o A company mission statement, if you have one. 
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Marketing 
Your marketing strategy is the heart of your business. Without a marketing strategy, 
finances fall by the wayside. How can you make money if you don't know how to 
sell your product? Who are your customers? How will you find them? How much will 
it cost to acquire and service them? 
Your marketing plan should include: 

o A summary of your market position and goals. 
o Your market objectives. Specific targets are more effective than vague 

announcements: "We will sell 150 widgets by the fourth quarter" is more 
convincing than "We will own the market in widgets." 

o Your target markets. 
o A strategy for each segment or market. 
o Marketing expenses and resources, and how they will be allocated. 
o The marketing channels you plan to use, such as e-mail marketing, radio ads, 

or highway billboards. 
o Competitive scenarios. What are your moves if, say, a competitor lowers its 

price as soon as you launch? 
o Communications strategy. Set up benchmarks to show when the marketing 

pays off. Connect the dots with the sales staff. 
o The implementation or marketing calendar. Plans are great, but if you don't 

also designate responsibility, set deadlines, and hold people accountable, 
marketing efforts will fail. 

The marketing section should detail the results of the customer or market research 
that you've done and explain what you foresee as difficulties in getting into the 
market (sometimes called "barriers to entry"). 
You want to answer some key questions for readers and investors, including: 

o The size of your market. 
o The percentage of the market (be realistic) that you intend to target. 
o The cost to reach this target. 

 
Do you have any special marketing advantages to offer, such as guarantees or 
distribution rights? Be sure that you cover those as well. 
Operations 
This is your tactical section. You need to provide details about: 

o Office or facility requirements. 
o Equipment needed or manufacturing capabilities. 
o Human resources (staff and contracted or consultant). 
o Systems for getting your idea up and running. 
o Inventory control or quality assurance processes. 
o The kinds of operation funds that this will take, including: 

 Rents 
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 Leases 
 Licenses 
 Registration 
 Production costs 

A floor plan of the space you've chosen, if your business is a manufacturing or 
production model. 

  
Financial projections 
 
This is your statement of what's coming in and what's going out. It should include: 

o A detailed outline of your cash flow expectations, usually for a 12-month 
projection. 

o A projected balance sheet. 
o Projections for sales, expenses, and margins of profit. 
o What it will take to get to breakeven and then to profitability, including the 

kind of cash drain you anticipate until then. 
  
Tone will tell 

It's easy to get bogged down in an avalanche of facts and figures when 
drafting a business plan. Don't. Walk a judicious line between narrative and 
statistics. You're telling the story of your business. You're making an argument for 
success (and perhaps backing). 
Here are some tips to make your business plan more compelling: 
Capture attention 

Your executive summary must be both exciting and readable. Avoid all 
technical or industry terms and jargon. If you must invoke complicated terminology 
or concepts, define them briefly. 
Put yourself in the mind of the reader 

The plan is about the market and how you will make money, not about how 
smart you've been to come up with a fabulous new product. Be sure that you stick 
to the goal of the plan, which is to convince readers that your business is viable. 
Be realistic 

Don't avoid weaknesses, and don't gloss over strong competitors. Everyone 
who reads a plan is an interested, astute professional. If you leapfrog over problems 
or difficulties, you lose credibility. 
Showcase your ending 

Be sure that the last page is as dramatic as the first. Don't trail off into 
numbers or detailed explanations. Sum up with as much excitement as you began. 
Chief Financial Officer 
10 tips for effective financial presentations 
 

When you present financial information to team members, investors, or other 
parties, it's essential that you not only communicate the basic information, but that 
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you help the audience analyze and actually understand it. To do this, you can create 
a Microsoft Office PowerPoint® presentation to help make your points in a way that 
would be impossible with just a verbal presentation and handouts. 
The PowerPoint paradox 

PowerPoint is a powerful tool with almost limitless design and production 
possibilities —  and therein lies the danger. With so much to choose from in 
PowerPoint, it's possible to overwhelm your content with your dazzling presentation. 
And it's so easy to create slides, that you can quickly make more than you'll ever 
have time to show. 
 

It's all about the story 

Financial presentations tell a story. You're not just showing a collection of 
profit-and-loss statements and balance sheets —  you're telling a story that your 
audience needs to hear. It may be a story of a new company with promising 
growth. Or, maybe it's a story about meeting market challenges. Whatever your 
story is, stick to it: Toss everything that doesn't help you tell it in a compelling, 
easy-to-follow way. Tell your story with simplicity and clarity. 

Many studies have been done on the best ways to present financial data. 
Communication experts, including David Brooks, 1990 Toastmasters World 
Champion of Public Speaking, agree on basic principles of effective presentations. 
These 10 tips can help you focus on your story and present financial information 
more effectively. 
 1. Limit the amount of information on each slide.    Most people can 

easily see five or six words per line and five or six lines per slide. The 
guidelines apply to financial reports — so instead of showing full reports, 
focus on just the main points, with no more than four to six columns and six 
to eight rows. For example, this simplified profit-and-loss statement is easy to 
read on paper, but on a slide it's more like an eye exam.    
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  People cannot read or retain this much complex information on slides. It's too 

small to read, and it's too much information to retain. Use your slides to 
make or illustrate your point, and save the detailed financial statements for 
the handouts.  

 2. Use charts.    Your audience would have a difficult time analyzing 12 
months' worth of data in a report, but they can instantly visualize 12 months 
of sales and net profit in a chart. Continuing with the preceding example, you 
can use a chart to show how sales from different areas are changing. 
Depending on the point you want to make, you could use pie charts to show 
how your overall product mix is changing. Or, you could play up the fact that 
although service sales are down, beverage sales more than made up for it 
and total sales and net income are up.  Unless you are comparing results, for 
example on two pie charts, use only one chart per slide. Make the charts as 
large as possible on the slide.   
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 3. Use a readable font and font size.    Some experts recommend a font 

designed specifically for online viewing, such as Tahoma® or Verdana®, but 
others would choose readable classic fonts, such as Goudy. Remember that 
ornate or very blocky fonts are difficult to read in slide shows, and try to 
keep the font size at 32 or greater. WordArt  (WordArt: Text objects you 
create with ready-made effects to which you can apply additional formatting 
options.) has its place, but less is generally more in a financial presentation. 
Mr. Brooks considers runaway WordArt to be "the mark of a pure amateur." 
He points out that typography is an art; fonts are carefully created by 
professionals. And then, "words are squeezed, twisted, or worse yet 
animated. It's comparable to listening to music at a different speed, totally 
destroying the artist's work."  

 4. Go easy on the transitions.    Venetian blinds and wagonwheel 
transitions are fun, but they can be distracting in a financial presentation. 
And checkerboard transitions can actually be difficult to look at when they 
come between slides that display mostly numbers. Mr. Brooks prefers the 
left-to-right wipe, but he says, "the important thing is to pick one transition 
and stick to it." Some experts recommend a different transition between 
major topics. In most cases, it's best to err on the side of simplicity. Let the 
audience notice slide content — not slide transitions.  Remember, if 
something doesn't add to your presentation's story, it probably detracts —
 and nothing distracts like a big transition fanfare to celebrate the pressing of 
the Next button.  

 5. Choose high-contrast backgrounds and colors.    According to Mr. 
Brooks, you can't go wrong with a black or dark blue background and white 
or light yellow text. Some people prefer black text on a white background; 
although the white background is somewhat harsher, it is easier to see in a 
room with more light. Bonus: When you use black text on a white 
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background, you don't have to dim the lights so low that you lose half your 
audience to a quick nap. If you add background designs, keep them simple 
and make sure they don't overlap and obscure your information. And 
consider the quality of the projection system you will be using. Beautiful 
backgrounds and colors may not look the same on the large screen as they 
do on your computer —  another reason to keep your backgrounds simple.  

 6. Use blank or black screens between illustrated points.    When 
the action is not on the screen, don't hesitate to insert a blank screen, or 
temporarily black out the screen. The focus will then be on you and your 
message —  not on the previous topic or the one coming up next. 

 7. Check for unintended color combinations or symbols.    It should 
go without saying that unless you're presenting financial statements for a doll 
company, avoid pink and purple. If it's not a Christmas boutique, stay away 
from green and red combinations. Likewise, look for incongruous background 
shapes, like shapes that look like stops signs on an otherwise positive 
financial presentation. 

 8. Provide useful handouts.    A good PowerPoint presentation seldom 
makes a useful handout without some adjustments. If you've kept your 
PowerPoint slides concise —  five or six words to a line and five to six lines 
per slide —  printing your slides one to a page would take reams of paper 
and have text so large it would strain the eyes. One solution is to print more 
than one slide per page. How?  

 1. Hide any slides you do not want to print. How?  
 1. On the Slides tab in normal view, do one of the following: 
 ▪ To select nonadjacent slides, click one slide, and then 

hold down CTRL and click each additional slide. 
 ▪ To select adjacent slides, click the first slide in the 

sequence, hold down SHIFT, and then click the last slide. 
 2. On the Slide Show menu, click Hide Slide . The hidden slide 

icon appears with the slide number inside, next to the slide you 
have hidden. Note   The slide remains in your file, even though 
it is hidden when you run the presentation.  

 2. On the File menu, click Print Preview . 
 3. To choose the page orientation, click Portrait  or Landscape  on the 

toolbar  (toolbar: A bar with buttons and options that you use to carry 
out commands. To display a toolbar, click Customize on the Tools 
menu, and then click the Toolbars tab.) . 

 4. To set headers and footers, click the arrow on the Options button, 
and then click Header and Footer  . 

 5. On the Print Preview toolbar, in the Print What box, click the 
Handout layout option you want. Two to four slides per page 
generally works well.  

 6. On the Print Preview toolbar, click Print . 
 9. Note   After you print, don't forget to unhide any slides that you need for 

your presentation.  Handouts are also the place for all the reference material, 
detailed charts, and any other information that is too difficult for viewers to 
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see in a slide presentation, or that they need to take away with them.  Avoid 
passing out more than a sheet or two of paper at the beginning of the 
presentation. Some viewers won't be able to resist looking ahead —  
distracting themselves and the people around them.  

 10. Arrive early.    Allow yourself plenty of time to make sure that you have 
everything and that it all works. You don't want to be searching for power 
cords and connections as your audience arrives. 

 11. Get to the point.    Remember that your audience is busy and intelligent. 
Make your points —  then know when to quit and let them read the handouts 
themselves. 

 

Summary 

By following these tips from the professionals, you can give more effective financial 
presentations. And when you see that your audience really understands the financial 
story you have to tell, you'll know that your presentation is a success. 

 
3. Project small-business profits 
 

 According to the U.S. government, 50% of all small businesses fail within the 
first three years. Unfortunately for many business owners, by the time they 
recognize the critical nature of their problems, it's too late. Most business owners 
share an inherent sense of optimism and believe that they're close to success. Many 
of them also share a sense of disbelief when their expenses continually outrun their 
revenues. 

If you're like many small-business owners, you might track the performance of your 
company informally and make business decisions based on intuition — which might 
be confirmed (or denied) when a monthly bank statement arrives. Even successful 
business owners struggle to determine accurately whether they're regularly 
operating at a profitable level. It's difficult for businesses to project profit levels 
based on target sales levels. 

Develop a profit projection 

A profit projection consists of identifying future income streams and expenses 
(outflows). The process enables small companies to identify tradeoffs inherent in 
any business. Although you probably recognize the immediate benefits of this type 
of planning, you might lack a structured approach and the appropriate tools to 
accomplish the task. 
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A profit projection weighs assumptions , projected revenues , and projected 
expenses . After you have established detailed sales and expense projections for a 
given period and have identified and noted key assumptions, you can use a simple 
formula to project profitability. It's essential to thoroughly review the results of this 
analysis. 

Assumptions 

Assumptions are at the heart of every financial projection and determine the 
usefulness of those projections. A considerable amount of time should go into 
developing these assumptions, and you need to review them thoroughly. In 
addition, assumptions should be clearly identified as such, and you shouldn't 
hesitate to modify them as needed to accommodate different business scenarios or 
to reflect real-world experience. 

Projected revenues 

When developing projections, it's wise not to be overly optimistic. For example, it 
doesn't pay to underestimate the impact of such factors as seasonality and the 
changing buying habits of your customers or to ignore the actions of your 
competition. If you do, you might overestimate attainable sales levels and develop 
unrealistic profit projections. 

When developing revenue projections, start with these steps: 

 • Identify repeat or recurring revenue sources   Because your company 
has a history with these customers, you can develop assumptions based on 
historical purchasing patterns. 

 • Document potential new customers and markets   Identifying 
prospective customers along with the expected revenues and unique product 
requirements helps substantiate growth projections. 

 

Projected expenses 

Companies tend to spend more time analyzing revenue streams and less time 
evaluating the cost structure required to support those revenue streams. 
Thoroughly analyzing your company's existing expense structure is crucial in 
developing a good baseline that can be used to project future expense levels. 

For many small businesses, two of the most significant categories of expenses are 
labor and overhead. 

 • Labor   When projecting labor costs, be sure to take into account the impact 
of such items as insurance and taxes, employee turnover, annual 
compensation adjustments, and overtime pay so that you're less likely to 
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underestimate total costs. If you're projecting significant growth, it's a good 
idea to quantify the capacity of current staff levels and identify the 
incremental costs required to meet growth targets. 

 • Overhead   Overhead consists of expenses that are incurred but are not 
directly tied to a specific customer or sale. Overhead typically includes items 
such as rent, insurance, utilities, and administrative expenses. Expected 
increases in overhead expenses, such as a rent increase, need to be factored 
into the profit projection. Pay particular attention to these indirect expenses, 
because it's easy to underestimate the impact that these overhead costs have 
on the profitability of a product or service. 

After you identify expense items, categorize the items as either "fixed" or "variable." 

 • Fixed expenses   These are costs that are incurred regardless of sales 
levels — for example, rent, electricity, and fixed wages. 

 • Variable expenses    These are costs that generally increase or decrease 
based on sales volumes, such as cost of goods sold and cost of direct labor. 

 

Do a breakeven analysis 

After you have created a profit projection, analyze sales and cost figures under 
different operating scenarios to determine breakeven levels. A breakeven level is the 
minimum sales level that is required to cover projected expenses. This analysis is 
useful for all firms, because it helps to determine revenue thresholds. 

Often, breakeven analyses result in aggressive revenue requirements. In these 
cases, reevaluate pricing and expense assumptions to ensure that they're 
reasonable. For example, variable costs, such as direct labor, might be reduced over 
time as your company becomes more efficient at producing your particular product 
or service. Cost estimates need to reflect these savings. 

Look at a variety of scenarios 

Because of unpredictable and constantly changing economic conditions, it's a good 
idea to develop several different breakeven scenarios. The results of these various 
scenarios provide valuable data that can help you make more informed short-term 
and long-term decisions. 

About the author    Gary Drake is a managing associate and Michael Kerrigan is a 
principal with Beacon Consulting Group, Inc. , in Boston, Massachusetts. Beacon 
specializes in providing operational and strategic consulting services to the 
investment management industry. 
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4. Summarize financial data for senior management 
 

 Companies should review their annual budgets regularly during the fiscal 
year to determine how well their actual budget results align with their initial budget 
targets. Management can perform a regular budget review to measure the 
organization's progress and to identify areas requiring changes in strategic direction. 
Unfortunately, budget reviews often become ineffective because of the following 
common mistakes: 

 • Too much detail    Budget reviews often require senior management to sift 
through reams of data to uncover relevant information. To allow for strong 
analysis, budget reviews must provide a clear financial picture. 

 • The wrong detail    Budget reviews that include only financial metrics can 
blind-side decision-makers. Budget reviews need to include operating and 
competitive metrics so that managers can gain a broader perspective about 
the company's position. Operating metrics drive financial performance, and 
changes to these drivers affect financial results. Competitive metrics help 
business leaders compare company performance against peers. 

 • The wrong context    Presenting data within the proper context supports 
better financial analysis and decision-making. For example, managers may 
feel comforted as they track their company's gradually rising stock price in 
isolation of other factors. But a stock price that significantly lags behind the 
competition may elicit a completely different reaction from decision-makers. 
Presenting data within its full context can make all the difference for 
decision-makers. 

Eliminate these common mistakes when communicating financial information to 
senior management, and you can create more productive and effective budget 
review sessions. 

5. Summarize budget information 
 

Help company managers judge financial performance by having them review a 
subset of key metrics, not line-item details. Poring over line items requires effort 
that is better spent on analyzing summarized data. 

When developing your budget, provide summaries in three categories: 

 1. Financial metrics    These include profit and loss metrics (such as revenue, 
gross margin, and operating profit) and balance sheet metrics (such as cash, 
inventory, and long-term debt). 

 2. Operating metrics    Also called key performance indicators (KPIs), these 
metrics include items that drive financial performance. Examples are head 
count, inventory turnover, and employee turnover. Operating metrics tend to 
be unique to specific industries. For example, a manufacturing company 
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might focus on inventory turnover, while a services company might focus on 
employee turnover. 

 3. Competitive metrics    Whereas the first two categories provide an internal 
focus, competitive metrics evaluate the entire market in which a company 
operates. Examples of competitive metrics are market share, number of new 
product introductions, revenue per employee, and number of employees. 

The financial, operating, and competitive metrics provide the details that are 
necessary for senior management to understand a company's financial results, 
including understanding which factors affect results and how a company's financial 
results compare with the competition's financial results. 

Present your summary in a budget review report, also known as a flash report. A 
sample budget review report might include the following details: 

 
 1. Category Key metrics 

Financial metrics  
(profit and loss) 

 ◦ Revenue 
 ◦ Revenue by region/product 
 ◦ Gross margin by region/product 
 ◦ Operating expenses 
 ◦ Net profit (loss) by region/product 

Financial metrics  
(balance sheet) 

 ◦ Cash 
 ◦ Receivables 
 ◦ Inventory 
 ◦ Property, plant, and equipment 
 ◦ Land 
 ◦ Payables 
 ◦ Long-term debt 
 ◦ Shareholder equity 

Operating metrics 
 ◦ Head count 
 ◦ Production quality 
 ◦ Production capacity 
 ◦ Revenue per employee 
 ◦ Profit per employee 
 ◦ Order accuracy 
 ◦ Employee satisfaction 
 ◦ Customer satisfaction 
 ◦ Inventory turnover 
 ◦ Asset utilization 

Competitive metrics 
 ◦ Revenue/market share 
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 ◦ Gross margin 
 ◦ Stock price/earnings per share 
 ◦ Head count 
 ◦ Sales head count 
 ◦ Productivity 
 ◦ Profit per employee 
 ◦ Number of new product introductions 
 ◦ Number of field sales offices 
 

Present budget information  Financial data presented during a budget review 
should provide a platform for critical thought. To help you accomplish these 
goals, consider using two tools: trend analysis and variance analysis.   

Trend analysis  Trend analysis presents data by showing how a specific metric 
changes over a period of time. Trending is best used when a metric is of critical 
interest to a company. For instance, if a company is starved for cash to satisfy 
its debt payments, cash may be trended on a weekly basis to determine how the 
company's cash position stands. But if a company is flush with cash, cash 
balances that are trended on a weekly basis would provide too much detail and 
thereby limit management's ability to focus on more important factors.  The 
following chart is an example of a trend analysis. The chart shows a company's 
revenue trend by quarter compared with its top competitor.    

This chart clearly shows the growth of both organizations, as well as the 
comparison between the two. The chart helps managers benefit from a fuller 
picture of the company's position. With just a glance, they can make informed 
decisions about growth or competition.   

Variance analysis  Whereas trend analysis depicts data over a period of time, 
variance analysis compares metrics against each other from one period to 
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another, from one competitor to another, or from target to actual. By identifying 
large variances (presented in either dollars or percentages), management can 
conduct a root-cause analysis and uncover what drives the variances. By doing 
so, management can pursue appropriate changes, which is one of the primary 
benefits of an effective budget review process.  The following is an example of a 
profit and loss variance analysis included in a budget review summary. 

   

 

The following chart is an example of a balance sheet variance analysis.   

 

Both the profit and loss summary and the balance sheet summary can be 
reviewed by users to easily determine variances for key metrics. To help you 
evaluate how a specific metric has changed over time, supplement this variance 
analysis with a trend analysis.  It's imperative that you provide clearly 
summarized financial, operating, and competitive data to senior management 
during budget reviews. Creating a useful budget summarization requires an 
understanding of the key operating factors that drive financial performance, as 
well as the competitive environment in which the organization competes. Using 
tools such as trend analysis and variance analysis, finance teams can create 
meaningful reports to help senior managers make insightful decisions that drive 
superior financial performance.    
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6. Echniques For Successful Forecasting 
 
As a strategic planner, you are under intense pressure to generate positive 
performance results for shareholders and investors. At the same time, you are 
seeing globalization open markets and create intense competition. Advances in 
technology and business processes allow your company to rapidly bring new 
products and services to the worldwide market. 

To succeed in this rapidly changing environment, your company can't rely on 
current growth levels and profit margins. You must regularly develop long-term 
strategic plans that consider factors such as: 

 • The viability of existing products and services 
 • Opportunities around new products and services 
 • The profit potential of internal investment options 
 • The rate of return on strategic proposals 
Forecasting is the process of predicting how profitable a product or service will be 
over the long term — and it is a critical part of strategic planning. 

A collaborative effort 

Unfortunately, many companies get their forecasts from finance personnel who 
might rely too heavily on historical data. To develop an effective forecast, it's best 
to assemble a team of subject matter experts from many different disciplines. For 
example, the team can include: 

 • Sales personnel to create a long-term sales forecast for a product or 
service. Salespeople understand the demand for the product and the level of 
competition in the marketplace. 

 • Human resources personnel to determine staffing requirements. 
 • Procurement specialists to determine supplier costs. 
 • Technology personnel to determine hardware and software needs. 
 • Finance resources to develop best-case, worst-case, and most-likely 

scenarios. 
This team approach can help you create a more accurate and useful plan. 

7. Successful forecasting techniques 
 

Forecasting techniques are evolving alongside technology. Identifying how 
you plan to use the forecast can help you decide on the most useful 
technique. Companies commonly use long-term sales forecasting, pro forma 
analysis, and capital budgeting analysis. 

Long-term sales forecast (three to five years) 
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Companies typically develop a three-year to five-year sales forecast. This 
forecasting technique uses assumptions about macroeconomic and product-specific 
data to project future sales levels. A long-term sales forecast might include: 

 • A forecast of the economic environment in which the company will operate 
over the life of the plan. 

 • A thorough analysis of products and services, growth opportunities, impact of 
competition, any significant investment required, and historical sales data to 
identify trends that might help support assumptions. You use the results of 
this analysis to develop expected sales volumes and pricing levels.  

 • Determination of expenses that are required to support sales projections. 
Typically, you develop baseline expense projections by looking at past 
expenses as a percentage of total sales. You must also look at other factors, 
such as inflation, deflation, and increases in cost of materials and cost of 
labor. Remember that significant growth projections most likely mean 
additional costs. These costs can have a major impact on profitability. As a 
result, you need to thoroughly scrutinize cost estimates.  

 • Calculation of projected profit levels. A company can also develop different 
scenarios to reflect changes in the relevant inputs. 

 
Pro forma analysis 

You can use the data generated from long-term forecasts to create a pro forma 
analysis, which projects balances and cash flows over a given period. This technique 
is useful for comparing several periods or evaluating the impact of different 
assumptions. 

A pro forma analysis can also help you assess the attractiveness of a potential 
merger. It provides useful data to support the negotiation process. 

Capital budgeting analysis 

Capital budgeting analysis uses projected costs and returns to evaluate long-term 
strategic investments. 

You can use this technique to help you determine whether to fund a proposed 
project. You begin a capital budget analysis by determining how much money 
comes in and goes out, and when. This can be a difficult exercise. It requires you to 
make assumptions about quality and quantity and to carefully review your 
assumptions. 

After you project your cash outflows and inflows, you must select a method for 
analyzing the data. Companies commonly use one of the following three methods: 
Payback Period, Net Present Value, or Internal Rate of Return. 

 • Payback Period is the amount of time required to recover the initial cash 
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investment. You determine this amount by adding up the cash inflows for a 
product or service and then determining when they will equal the total cash 
outflow of the project. You typically approve projects that recover their 
investment within an acceptable amount of time.  

 • Net Present Value discounts the expected cash inflows to the present value 
by using an acceptable interest rate. Companies subtract the initial 
investment from the total to determine the project's net present value. You 
typically approve projects with a positive net present value.  

 • Internal Rate of Return is the interest rate that gives you a net present 
value of zero. You usually need financial tools to determine this rate. You 
typically approve projects that have an Internal Rate of Return that exceeds 
the assumed cost of capital.  

An ongoing process 

Strategic planning needs to be a dynamic process, not an annual activity. If your 
company is surviving in today's market, it constantly introduces new products and 
services or reinvents existing ones. As a result, you must constantly reevaluate 
assumptions and their impact on your long-term financial plans. Successful 
forecasting is a powerful tool. When used properly, it plays a key role in the 
strategic decision-making process. 

 
About the authors    Gary Drake is a managing associate and Michael Kerrigan is 
a principal with Beacon Consulting Group, Inc. , in Boston, Massachusetts. Beacon 
specializes in providing operational and strategic consulting services to the 
investment management industry. 
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8. Use what-if scenarios to project future values 
 
Microsoft Office Excel 2003 
Projecting future values can be an important part of the financial decision-making 
process. It's often helpful to project more than one set of values to find out how 
they affect your results. You can do this easily with what-if scenarios — sets of input 
values that Excel 2003 can substitute automatically in your worksheet. 

What-if scenarios can help you answer questions such as: 

 • How would changing my variable cost per unit affect my net profit? 
 • What would my estimated capital gain tax liability be if I sold certain 

investments? 
 • How would my loan payments change if I found a lower interest rate? 
You can create and save different scenarios on a worksheet and then switch 
between scenarios to view different results. You can also create a summary or 
PivotTable® list  (PivotTable list: A Microsoft Office Web Component used to create 
an interactive list that summarizes and analyzes data, such as database records, 
from various sources. Users can view the list in a Web browser and change its 
layout.) with the results of all your scenarios. 

 

Try it with a breakeven analysis 

To do a breakeven analysis and find out how changing the variable cost, fixed cost, 
unit sales, or price will affect your profit, you can define different values for these 
variables and then switch between scenarios to compare the results. 

The following illustration shows the current breakeven analysis for this example. 

Breakeven analysis: Current scenario 

 

Create scenarios 
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 1. On the Tools menu in Excel, click Scenarios . 
 2. Click Add . 
 3. In the Scenario name box, type a name for the scenario. 
 4. In the Changing cells box, enter the references for the cells that you want 

to change, or hold down CTRL and click each cell. In this example, to try a 
scenario of a lower price and projected higher unit sales, hold down CTRL, 
and then click cells B2 and B3.  Note   To preserve the original values for the 
changing cells, create a scenario that uses the original cell values before you 
create scenarios that change the values.  

 5. Under Protection , select the options you want, and then click OK . 
 6. In the Scenario Values dialog box, type the values you want for the 

changing cells. For example, for $B$2 (price per unit), type 6.25 . For $B$3 
(unit sales), type 110000 . 

 7. To create the scenario, click OK . 
 8. If you want to create more scenarios, click Add again, and then repeat the 

procedure. When you finish creating scenarios, click OK , and then click 
Close in the Scenario Manager dialog box. 

Display a scenario 

 1. On the Tools menu, click Scenarios . 
 2. Select the scenario you want to display, and then click Show . 
The values for the scenario are automatically substituted in your worksheet. 

Breakeven analysis: Higher price scenario 

 

Create a scenario summary report or PivotTable report 

 1. On the Tools menu, click Scenarios . 
 2. Click Summary . 
 3. Click Scenario summary or Scenario PivotTable . 
 4. In the Result cells box, enter the references to the cells you want to display 

in your report — generally cells whose values are changed by the scenarios. 
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In this case, enter B6:B8 to find out how the scenarios affect total costs, 
total revenue, and profit. 

Note   You don't have to specify result cells to generate a scenario summary report, 
but you must specify them for a scenario PivotTable report  (PivotTable report: An 
interactive, crosstabulated Excel report that summarizes and analyzes data, such as 
database records, from various sources, including ones that are external to Excel.) . 

The scenario summary report displays the variables for each scenario and the result 
cells. 

Scenario summary report 

 

The PivotTable report displays the result cells for each scenario. You can use the 
drop-down arrows to choose the results you want to be displayed. In this example, 
even though total revenue is lower if you raise the price, profit is higher. But if you 
lower the price, total revenue is higher and profit is lower. 

Scenario PivotTable report 

 

You can try other scenarios and find out how they affect net profit. For example, 
what if the variable unit cost rises by 25 cents per unit, but price per unit stays the 
same? By using scenarios, you can create as many scenarios as you need to help 
plan your business strategy. 
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9. Use ROI analysis to prioritize technology purchases 
 

In the late 1990s, many finance and IT organizations received a rude surprise after 
deploying highly touted technology that provided little return on their investment 
dollars. As a result of these costly mistakes, organizations now consider it 
imperative to evaluate the strategic and measurable benefits and costs of 
technology as part of a business case before they make a purchase decision. 

Companies that are successful at selecting technology are those that use return-on-
investment (ROI) analyses to guide the investment decision process. Organizations 
can use ROI analyses as part of well-rounded business cases to prioritize technology 
investment decisions. Yet most finance organizations struggle to develop a business 
case for technology investments that supports changing business requirements or 
provides the expected level of business value. 

This article provides a framework for incorporating an ROI analysis into the 
purchasing decision process by using two key success factors: 

 • Common business case template    A common business case template 
contains components that capture the proposed technology's strategic 
benefits, ROI potential, and deployment risks. 

 • Technology evaluation process    A clearly defined evaluation process 
includes procedures for developing, reviewing, and accepting or rejecting a 
technology business case. 

Components of a well-rounded business case 

A well-crafted business case gives managers the information they need to evaluate 
and prioritize a proposed technology investment. Your business case should include 
the following three components: 

 1. Strategic benefits    Describe the qualitative benefits that drive a business 
sponsor's reasons for requesting the technology. Strategic benefits are often 
important for driving business success but are difficult to quantify. For 
example, a CFO may want a new reporting package that she can use to 
analyze financial results more efficiently and accurately. Such a benefit is 
important to the business, although not always easy to quantify. 

 2. ROI analysis    This component is the core of the business case. It helps 
determine whether the measurable value generated by the investment 
exceeds the costs over the useful life of the investment. It's critical that 
everyone in an organization use a consistent ROI template, because 
management can use the template to assess competing technology 
investment requests. The ROI section of a business case must clearly present 
the technology's benefits by using two metrics:  

 ◦ Net present value (NPV)    This financial calculation shows the 
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discounted net benefits of an investment over its lifetime. The NPV is a 
critical metric that can be compared with other investments of any size 
. A positive NPV (over $.01) indicates that a company will receive a 
positive return on its investment, based on a required rate of return. 

 ◦ Payback    Payback, which is a simpler measure, indicates when an 
investment's benefits are expected to exceed its costs. Payback is 
usually expressed in months. Companies often require that an 
investment pay itself back in a specific time period, such as 15 
months. Otherwise, management is likely to limit the company's 
investment or deny the request altogether. 

 3. Risk    Often overlooked, a good business case identifies the major risks 
associated with the implementation of the new technology, as well as the 
benefits gained. A well-rounded business case identifies these risks for 
management and provides mitigating strategies to ensure that the 
technology's benefits are achievable. 

Sample business case 

To bring these concepts to life, consider the VP of operations for a growing 100-
store high-end retailer. The VP believes that implementing a new point-of-sale 
(POS) software program is vital for the company's continued growth. The company's 
current POS software is beginning to show strains from the company's expansion 
and increasing inventory. Customer service issues are arising from errors in the POS 
software. These errors are a major concern for the company, because its mission is 
to provide exceptional customer service. 

Deploying new software throughout 100 stores is expected to cost $3.5 million in 
software, hardware, and deployment costs, as well as an additional $1 million per 
year for training and maintaining the software over its useful life. The 
implementation time frame is relatively long (over 10 months) and requires that a 
large amount of data be transferred from the old system to the new one. To justify 
this significant technology investment, a business case is required. 

Using the three components discussed above, the VP of operations should structure 
a business case to look something like the one that's summarized in the following 
table. 

Business case area Detail 
 
Strategic factors 
 • A new POS system will help improve customer satisfaction, which is core to 

our company's mission. 
 • A new POS system will support our current workload and future growth. 
ROI factors 
 • Expected useful life of software = 5 years 
 • Year 1 cost = $3,500,000 
 • Future costs = $1,000,000 per year 
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 • Payback = 15 months 
 • Net present value (NPV) = $3,000,000 
Risk factors 
 • Implementing the new software will take more than 10 months. To mitigate 

this risk, we will use a systems integrator that has a successful track record 
of deployment for retailers that are similar to our company in size and 
complexity. 

 • The implementation requires that all current data be transferred to the new 
system. To mitigate this risk in preparation for the eventual migration, we will 
begin a data-cleansing project immediately. 

A great deal of detail and analysis is still required to complete this business case 
structure, particularly for the ROI metrics. But by incorporating a clear structure that 
captures the three components, the VP of operations has developed a business case 
that makes it easy to evaluate the proposed software investment based on its 
potential value to the business. 

Technology evaluation process 

An organization should use a formal technology evaluation process for all 
investments over a certain threshold — typically for more than $100,000 for 
medium-sized to large-sized companies. This evaluation process should include the 
following steps: 

 • Develop the business case    The business sponsor of a proposed 
technology investment should draft a business case by using the components 
described earlier in the article. 

 • Review    A technology steering committee should evaluate business cases 
on a periodic basis. This committee, comprising line of business, IT, finance, 
and executive leaders, assesses each case on its merits to ensure that the 
company pursues only investments that add true value to the business. 

 • Select the business case    After evaluating a business case and 
comparing it with other investment proposals, the committee either accepts 
or rejects it. Depending on the committee's reasons for the rejection, 
rejected cases may be eligible for resubmission to the steering committee 
upon revision by the business sponsor. 

 • Fund the investment    Accepted investments are funded by finance and 
use procurement to drive down project costs. 

As with any business process, the technology evaluation process should be formally 
documented and communicated to the organization's leadership to ensure that all 
major investments are consistently reviewed. It is advisable that this process be 
mandatory in order for funds to be released. 

Sample evaluation process 

To continue with the example of the proposed POS software investment, assume 
that the retail company's technology steering committee evaluates the POS software 
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proposal from the VP of operations, along with two other requests for investment. 

One investment request is for new budgeting software, which is nearly identical in 
cost to the POS software, and provides strategic benefit to the company by 
enhancing the budgeting process. However, the ROI investment analysis for the 
budgeting software indicates that it would take nearly three years to reach 
investment payback, leading the steering committee to make this request a lower 
priority when compared with the POS software request. 

The other investment request is sponsored by the merchandising team, which seeks 
to deploy a new software system to help with markdowns for apparel that is not 
selling. The cost for this software is about $1 million. Although costly, the 
quantifiable benefits for this software are high, leading to a strong NPV and 
payback. However, because the company considers itself a high-end retailer with a 
mission to satisfy its customers, the steering committee considered the value of 
marking down merchandise to be less than the value for customer-facing POS 
software. But the committee considered the markdown software to be a more 
valuable investment than the budgeting software. 

After considering the ROI analysis, risks, and mitigating strategies associated with 
the three business cases under evaluation, the steering committee decided to fund 
both the POS and markdown software but reject the request for budgeting 
software. This example illustrates how ROI analyses, when used as part of a well-
rounded business case, helped the steering committee prioritize technology 
investment decisions. 

Organizations should evaluate formally prepared business cases for determining 
whether to invest in costly technology. Organizations that are adept at making such 
investments create a common business case framework that provides a detailed ROI 
analysis. To ensure that investment dollars are spent properly, organizations must 
use a consistent evaluation process that weighs the strategic and quantifiable 
benefits of competing investments when prioritizing funding decisions. 
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10. Build better budgets with the power of forecasting 

 Nearly all financial analysts and managers understand the importance of a 
strong budgeting process, but many would be hard-pressed to describe their 
company's process as world class. Many companies carry out their budget process 
as a one-time, isolated event. By using a static budgeting approach, companies lose 
the opportunity to adapt to constantly changing business conditions. 

Companies need a flexible budgeting approach that enables them to respond to 
changing business conditions throughout the year. The integrated budgeting 
approach provides a framework that you can use to integrate forecasting and 
budgeting. By using the integrated budgeting approach, your company can adapt 
budget targets, strategies, and compensation to the changing business climate. 

Benefits of budgeting 

The budgeting process enables a company to determine next year's: 

 • Financial targets , including revenue, margin, profit, cash flow, and debt 
levels. 

 • Operating targets and key performance indicators , including inventory 
turns, product and service quality, supplier effectiveness, sales closing rate, 
and customer satisfaction. 

Developing financial targets is critical to a well-designed annual operating strategy 
and performance incentive framework. A strong budgeting process also provides a 
direct link to the organization's overall strategy, management buy-in on strategic 
goals, and the identification of the assumptions that drive the budget. 

Static budgeting limits your options 

In an ideal world, companies that use successful budget processes can reap the 
benefits of good budgeting. In reality, few companies do. Many companies do not 
realize all the benefits of good budgeting because they consider their budgeting 
season a one-time event. These companies do not reopen their budgets until the 
following budget season. 

By following a static budgeting process, you lose two major opportunities. You are 
unable to reassess budgeting assumptions and to adjust operating and 
compensation strategies in response to changing business conditions. 

You can't revise your assumptions 

When creating a static budget, management essentially makes its best educated 
guess about next year's performance. The prediction is based on certain 
assumptions. As economic, market, competitive, and operating events unfold, the 
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assumptions prove to be either right, wrong, or somewhere in between. 

Sometimes management's assumptions totally miss the mark, leaving the 
organization vulnerable to risk. As a result, the original operating budget might look 
like a very poor educated guess by Month 4. 

You can't adjust your strategies 

If you base your budget on incorrect assumptions, your operating strategies might 
be addressing targets that should now be of lower priority. Your company might 
also need to adjust its compensation strategy. If the company will not meet its key 
performance targets, low employee morale might occur when employees anticipate 
that they might receive reduced variable pay at the end of the period. 

Static budgeting in action 

To see how static budgeting holds a company back, consider the example of a small 
regional retailer of high-end apparel. 

Company's objectives    The company developed a plan that focused on three 
objectives: annual revenue growth of 20%, customer satisfaction of 99.99%, and 
maintaining its premium brand image. The company considered earnings an 
important afterthought, based on the company's previously high margins relative to 
its peers and the strong economy. 

Management set the annual operating budget and strategy with these three high-
level objectives in mind. An annual bonus plan drove compensation and tied 
employees to the objectives (33.3% for each target). 

Changing economic conditions    As the year progressed, economic conditions 
unexpectedly began to sour. As a result, the customer base began shifting to 
discounters, reducing revenue. By midyear, employees lost faith in the annual 
budget and feared that they wouldn't receive their bonuses. 

Company's response to decreasing revenue    To combat decreasing revenue 
(and to help meet bonus targets), management promoted certain products. 
However, the company did not substantially lower prices in order to protect the 
store's premium image, which a brand consultant measured quarterly. To ensure 
strong customer satisfaction (also measured quarterly by a consultant), the 
company continued its lenient return policy. 

End-of-year results    Not surprisingly, operating results quickly deteriorated. By 
the end of the fiscal year, the company had an enormous loss. Even so, many 
employees received partial bonuses for meeting customer satisfaction and brand 
perception targets. Because of aggressive discounting, the company achieved a 
portion of its revenue target, causing incentive payouts despite the company's large 
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operating loss. After the year was over, management laid off 10% of the workforce 
in an attempt to cut costs. 

Analyzing the company's situation    Why did this company pay bonuses 
despite a poor operating year that resulted in huge losses? Was the original plan 
and operating strategy flawed? Though it's highly simplified, this case illustrates 
how a static budgeting process can weigh down a company. The section "Integrated 
budgeting in action" addresses how this company could have adjusted its strategy 
midstream if it had a more flexible budgeting process. 

What is integrated budgeting? 

Integrated budgeting is a flexible budgeting framework that integrates forecasting 
within the budgeting process. By using integrated budgeting, you can respond to 
changing business conditions throughout the year and avoid the pitfalls of a static 
budgeting process. Integrated budgeting consists of five elements. 

Classification of performance targets    Management needs to prioritize 
financial and operating targets. The company should treat primary targets as 
relatively immovable during the fiscal year, regardless of changing business 
conditions. Secondary targets can be modified, exchanged, or even eliminated in 
order to support primary targets. 

Operating reviews    Operating reviews are the heart of integrated budgeting. 
Conducted on a quarterly basis, operating reviews provide the key stakeholders in 
the budget process with a forum to assess results and realign targets, strategies, 
and compensation. 

Budget reforecasting    Integrated budgeting relies on reforecasting that uses the 
rolling budget and forecast to assess operating results. Stakeholders can use the 
rolling budget and forecast to see the variances from the budget targets to actual 
results and to analyze the causes of any variances. This tool also provides the 
workspace where you can conduct a "look-ahead forecast" to analyze the effects of 
changing certain assumptions or targets for the remainder of the fiscal year. 

Realigned operating strategy    After you develop a look-ahead forecast, 
management should reevaluate operating strategy to focus on meeting new 
objectives. 

Realigned compensation    The critical missing link in aligning strategy to 
performance is often compensation. If the organization bases management and 
employee compensation at least partly on enterprise or business unit performance, 
performance goals should be reset after the operating review. 

To avoid renegotiating compensation targets, management should change 
compensation targets selectively. In general, if the organization is not meeting key 
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performance targets, management must stick to these targets and allow flexibility 
only for top performers. 

Integrated budgeting in action 

To see how a company can benefit from using integrated budgeting, consider again 
the example of the small regional retailer of high-end apparel discussed in the 
"Static budgeting in action" section. What would management have done if they 
used a robust and flexible budgeting process rather than a static budgeting process? 

The five integrated budgeting elements provide a structure for comparing what the 
company did using a static budgeting process with what they could have done if 
they used an integrated budgeting process. 

Classification of performance targets 

 • Static budgeting    The company's original priorities were aggressive 
revenue, customer satisfaction, and a strong brand image. Though they are 
worthy, these goals required tradeoffs that resulted in poor operating 
performance. Management needed to decide which of these goals were 
primary and secondary so that the company could make midstream 
adjustments. 

 • Integrated budgeting    At the beginning of the year, the retailer could 
have classified brand image and customer satisfaction as primary goals and 
revenue growth as a secondary goal. 

Operating reviews 

 • Static budgeting    Management continually adjusted operating strategies 
by implementing new promotions at the local level without considering all of 
the causes of the revenue shortfall. Management also did not focus on 
remedial actions that it could have taken in response to the revenue shortfall. 

 • Integrated budgeting    The retailer could have conducted operating 
reviews on a quarterly basis. During the Quarter 1 review, after assessing the 
economic situation, management could have upgraded operating income to a 
secondary goal that had a higher priority than that of revenue growth. 

Budget reforecasting 

 • Static budgeting    Despite the dramatic change in business conditions, the 
retailer did not formally adjust targets in response. The static budget became 
a relic, as opposed to being a key management tool. 

 • Integrated budgeting    The retailer could have used a rolling budget and 
forecast to determine the causes of key variances. Obvious causes were the 
economy and competitors that were stealing business with copycat apparel 
lines. Management could have revised the look-forward forecast to reflect a 
weaker economy. To spur revenue growth, management could have 
developed several new marketing strategies that did not compromise brand 
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image or customer satisfaction. 
Realigning operating strategy 

 • Static budgeting    Management did not comprehensively adapt its 
operating strategy to respond to changing business conditions. The retailer 
implemented program strategies locally, focusing on achieving secondary 
targets at a high cost. 

 • Integrated budgeting    The retailer could have implemented new 
competitive and marketing strategies based on the operating review 
reforecast. After evaluating the reforecasted budget, management could 
have cut costs by reducing the workforce by 2%, cutting the bottom 2% of 
performers. 

Realigning compensation 

 • Static budgeting    Because the company used a static compensation plan, 
employees focused on meeting targets that were not in the company's best 
interest. 

 • Integrated budgeting    For the last three quarters, the company could 
have modified compensation by using a "60/40 plan" with compensation 
based on the following: 30% on customer satisfaction, 30% on brand image, 
20% on operating income, and 20% on revenue growth. Quarter 1 bonuses 
could have been paid under the old plan to eliminate renegotiating. 
Management could give a select group of high achievers (the top 10%) 
concessions to ensure continued motivation. 

Benefits of integrated budgeting 

By using the integrated budgeting approach, the apparel retailer could gain many 
benefits. 

Focus    Instead of chasing multiple and often conflicting performance targets, the 
retailer would have had the flexibility to refocus on the core targets (brand image 
and customer satisfaction) that were achievable during the economic downturn. 
Management would have been able to more effectively consider the tradeoffs 
between targets, which might have helped stem a large operating loss that led to 
layoffs. 

Workforce alignment    The average employee's variable compensation would 
have been better aligned with the company's overall performance. 

Fairness    Employees would not have been completely demotivated by the poor 
economic conditions (particularly top employees, who would have enjoyed more 
compensation flexibility). Likewise, the company would have likely paid out 
deservedly smaller bonuses, which makes sense when operating results are poor. 

Innovation    By conducting quarterly operating reviews, management could have 
reviewed reforecasted budgets in order to determine the causes of variances. A 
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more intelligent forecast of future activity could have been built. The operating 
review would have become a forum for innovation, where key players discuss the 
challenges of the business climate and create strategies to overcome the 
challenges. 

11. Build better budgets 

The integrated budgeting approach provides a method that you can use to lead 
your company's response to ever-changing business conditions. By adding 
forecasting to the budgeting process, your company can successfully adapt to the 
situations that defy the initial budgeting assumptions. 

About the author BearingPoint provides business consulting, systems integration, 
and managed services to Global 2000 companies, medium-sized businesses, and 
government organizations. 
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PART 4. HUMAN RESOURCE MANAGEMENT 
 
1. Conduct an effective pay study 
 

Why conduct market pay studies? 

Seventy-five percent of all employees are looking for new jobs, according to the 
2004 U.S. Job Recovery and Retention Survey released by the Society for Human 
Resource Management (SHRM) (www.shrm.org) and CareerJournal.com. These 
survey results also reveal that 43% of employees who are job searching seek better 
compensation. 

Market pay is the compensation paid for a specific job, including information about 
bonuses and benefits, that is determined by a continual analysis of the competitive 
job market. Increasingly, with data so readily available, your candidates and internal 
employees are negotiating their salaries armed with knowledge of market pay data. 
As an employer, you should be prepared to respond. Market pay data should be a 
part of your organization's overall strategy to determine equitable compensation. 
Otherwise, you might not remain competitive. 

Recently, a CFO job candidate negotiated his salary with a small company. His 
potential salary, from legitimate market pay studies, ranged from $120,000 to 
$210,000. The potential employer, because of its size, needed to settle at the low 
end; the candidate, of course, sought the higher end. 

During the negotiations, the candidate cited six market pay studies, which added to 
the complexity of the discussions. Market pay studies identified by the potential 
employer, however, convinced the candidate that the company's offer was worthy, 
though not necessarily what the candidate desired. The company and candidate 
settled at $170,000. 

2. How market pay studies help your organization 
 

A recent study by WorldatWork (www.worldatwork.org), an association for 
compensation and benefits professionals, found a correlation between an 
employee's satisfaction with pay and an understanding of how the employee's 
organization determined pay. 

Although many organizations use salary surveys and other market data to 
determine pay ranges, only 36% of the people responding to 2004 U.S. Job 
Recovery and Retention Survey knew how their pay rate compares with market 
rates. A similar percentage of survey respondents were unclear about how pay 
ranges and rates were determined in their organizations. 
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Because a key factor in employee retention is satisfaction with pay, this figure 
should serve as a signal to employers that they need to conduct market pay studies 
and communicate the results to their employees. 

In addition to retention, effective market pay studies also help your organization: 

 • Carry out your compensation philosophy (above market, below market, and 
at market). 

 • Attract talented employees. 
 • Negotiate fair compensation with candidates. 
 • Control compensation costs. 
 • Communicate the rationale for salary grades and ranges. 
 • Improve employee satisfaction through fair compensation practices. 
 • Improve interaction with and trust in management. 
To accomplish these results, you should create and maintain an effective market 
pay measurement system, and you should be knowledgeable about how to integrate 
salary surveys into your company's compensation philosophy and practices. 

How to conduct an effective market pay study 

In an ideal world, you'd develop a list of companies that have positions similar to 
your company's positions, and then you'd communicate job descriptions and pay 
ranges for each position. You would then have the market pay information needed 
to establish and communicate employee compensation. 

In reality, collecting data that accurately reflects the market rates for jobs in your 
organization is more difficult. Because your organization's best comparable jobs are 
likely to be those of your main competitors, information-sharing is unlikely. As you 
conduct a market pay study, keep in mind that you should use market pay data as 
part of the overall strategy — not as the sole strategy — to determine equitable 
compensation within your organization. 

Traditional job evaluations, reporting relationships, and comparable jobs in similar 
pay ranges should all help drive your compensation. Your organization's 
compensation philosophy and commitment to fair, equitable, and nondiscriminatory 
pay practices must also play a role, in addition to conducting market pay studies. 

Conduct an effective market pay study 

 1. Assess all jobs within your organization by using job analysis to produce 
detailed job descriptions. This step is critical. Employees who know that their 
compensation is partially determined through market analysis of comparable 
jobs are more likely to object to their compensation if the job descriptions 
that are used for comparison do not accurately reflect the content of their 
jobs. 

 2. Identify salary surveys that most accurately match your organization's types 
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of jobs in your geographic region. Geography is a critical factor because it 
includes variables such as the local cost of living, the availability of needed 
talent in the region, and the condition of the local economy. The most 
valuable data also factors in the size of a company, the number of 
employees, and the size of a community. In addition, you can glean more 
information from surveys that show the number of jobs that were averaged 
to determine the salary range for each type of job. 

Obtain salary surveys that best reflect your jobs 

 1. Obtain salary surveys through your national professional organizations, local 
companies, and community groups such as the Chamber of Commerce, local 
IT groups, and local professional associations. Keep in mind that smaller 
groups, especially those that generate market data through member surveys, 
have fewer points of data comparison and have many jobs with no relevant 
data for a company of your size. 

 2. Look into national organizations that produce market pay studies. The 
information from Compdata Surveys (compdatasurvey.com), for example, 
provides real data collected from thousands of companies across the United 
States. Other sources for market pay data include Salary.com and the 
WorldatWork vendor directory. 

 3. Benchmark or match each of your jobs to comparable jobs in the salary 
surveys that you selected. To perform the benchmarking, use a cross-
functional team or work with employees across departments. Make sure that 
you: 

 ◦ Match jobs to job content, not to job title. As examples, a human 
resources (HR) generalist in your company might perform all of the 
responsibilities carried out by an HR manager in a larger company. 

 ◦ Match jobs to the job content, not to the person currently filling the 
role. 

 ◦ Match jobs as closely as possible. In smaller companies, employees 
tend to have many diverse roles. When matching comparable jobs in 
larger companies with a similar job in your smaller company, be 
mindful of these role differences. For example, in a smaller company, 
a marketing manager might also be responsible for selling products in 
the field. The market data for this kind of position should analyze both 
job types. 

 ◦ Match jobs by using your company's compensation philosophy. If your 
company pays above-market wages to attract superior candidates, 
benchmark your jobs above the 50th or 75th percentile. If your 
company practices variable compensation, benchmark those jobs with 
bonus potential figures. 

You might find that some market pay surveys are more useful to your organization 
than others. Some surveys more accurately reflect your jobs and the salary levels 
with which you attract superior candidates. These surveys allow for more equitable 
division of the pay in your budget by the positions in your organization. 
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Market pay studies are critical for establishing equitable and fair compensation 
within your organization. Attracting and retaining superior employees for your jobs 
is critical to your success as a business, particularly as demographic changes (such 
as population aging) create a more competitive job market because there are fewer 
candidates. You can't afford to let the market pass you by. An effective market pay 
study is your answer. 

3. Develop pay scales by using market pay data 
 
Market pay is vital 

Is the pay in your organization competitive with the pay in today's job market? You 
can answer this question by taking a look at the quantity and caliber of the 
applicants who you are attracting. Equally, high employee retention rates 
demonstrate a great deal about your organization's competitiveness in the 
marketplace. 

Regardless of what workplace studies reveal, working is about compensation. 
Working can be about much more, too, but the bottom line for people is that their 
work must pay their bills. Employees desire reasonable, viable, and market-
responsive salaries. Compensation is the visible demonstration that an employee's 
work is valued. Consequently, effective compensation is one of an employer's most 
important and powerful communication tools. 

Collecting market pay data 

Therefore, the value that you assign to jobs in your organization's compensation 
system should be driven by the most up-to-date information about market pay. You 
can obtain practical market pay data, which includes information about salary, 
benefits, and bonuses, from a continual analysis of the competitive job market. 

Large organizations, which have many resources and compensation professionals, 
might even design and administer custom surveys to regularly obtain market pay 
data. Smaller organizations must use market surveys conducted by national, local, 
and professional associations. 

Or you can match your jobs to commercially available compensation studies that 
provide compensation information for: 

 • Your industry 
 • Your geographic region 
 • Your company size 
 • The number of people that you employ 
 • Your job descriptions 
Assess the potential value of salary survey data by the method used to compile it 
and the similarity of the data's job descriptions to the jobs you need to match. 
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In addition to salary surveys, you can collect market data from similar organizations, 
although you might want to avoid the illusion of price fixing. Market information is 
also available from colleagues, from professional association surveys of members, 
and from the National Compensation Surveys available on the Bureau of Labor 
Statistics site (www.bls.gov). You can get an indication of the average pay for 
particular jobs by searching online job boards. 

How to use market pay data to construct pay scales 

Regardless of your market pay data sources, you should use the following steps to 
apply market pay data for developing appropriate pay scales: 

 1. Verify that your data is correct, and match the data to your specific job 
descriptions to appropriately value each job. 

 2. Arrange the jobs along a market line according to the value of the job as 
determined by your market pricing data. 

 3. Use the market line to develop pay grades by grouping jobs with similar 
market values. The number of pay grades that you need is determined by the 
number of hierarchical levels you have in your organization. Numbers of 
levels of supervision, technical sophistication of jobs, and your desire to 
create ranges that allow for career development without promotion are also 
factors in determining the number of pay grades. 

 4. Determine the pay range for each pay grade. The pay range is the distance 
between the minimum and the maximum compensation point allotted to each 
job. This allocation is the result of your market pay data research and your 
internally conducted job evaluations. Jobs with lower salary values have more 
narrow ranges, and executive jobs have the largest salary ranges. According 
to the Society for Human Resource Management site (www.shrm.org), the 
following are common ranges: 

 ◦ Nonexempt manufacturing: Narrow range of 20%–25%, or flat rate 
 ◦ Nonexempt clerical: Relatively narrow range of 30%–40% 
 ◦ Exempt professional, administrative, supervisory: Wider range of 

40%–50% 
 ◦ Exempt managerial and executives: Widest ranges of 50% or more 
 5. Calculate a minimum point, midpoint, and maximum point in each pay range, 

with equal distance between each point. According to the SHRM Web site, 
the following is a typical pay structure: 

 ◦ Production employees: 10%–20% 
 ◦ Clerical employees: 20%–40% 
 ◦ Exempt employees: 35%–50% 
 ◦ Management employees: 45%–60% 
 6. Draw a market line across your pay grades based on your organization's 

compensation philosophy. 
 ◦ Organizations that have highly technical, hard-to-replace positions 

might want to draw their organizational pay line across the 75th 
percentile and pay above-average wages. 
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 ◦ Stable industry organizations might want to pay below the midpoint 
but compensate with better-than-average benefits. 

 ◦ Organizations with high turnover and ongoing training might want to 
pay at the minimum point, because employees are expected to work 
only short-term assignments. 

 7. Assign the appropriate value to each job based on your organization's 
compensation philosophy and the qualifications, experience, potential 
contribution, and market value of each job holder. 

What is a broadband pay structure, and why does it matter for market 
data? 

In a broadband pay structure, the numbers of salary grades are consolidated. Fewer 
ranges mean that the spread of the ranges is wider and that there is less overlap 
with other ranges. 

Broadband pay structures evolved as organizations sought to flatten their 
hierarchies and move decision-making responsibilities closer to the point of the 
necessity and knowledge in organizations. In flattened organizations, fewer 
promotional opportunities exist. 

Broadband pay structures therefore provide an opportunity for career growth 
without the necessity for promotion. Broadband pay structures encourage the 
development of broad employee skills, because nonmanagerial jobs are 
appropriately valued and skill development is rewarded. 

These pay structures are not as sensitive to rapidly changing market pricing 
conditions, so they cost less to administer and manage. According to Keith Fortier 
and Christopher Fusco, in their Salary Structures white paper on Salary.com: 
"Whereas the design characteristics of traditional structures emphasize internal 
equity and focus the employee's attention on the world inside the firm, 
broadbanding focuses employees on the changing needs of the organization and 
helps them experience an internal culture that more closely reflects the external 
business environment and the competitive recruiting market." 

Conclusion 

Market pay data is an essential component in developing a salary structure for your 
organization. Combined with job evaluation data and your organization's 
commitment to internal pay equity, market pay data is the best tool for developing 
pay grades and pay ranges. Broadband pay structures, touted since the early 1990s, 
offer an additional opportunity to use the interchange between your internal pay 
structures and the marketplace. 
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Company Name 
Salary Analysis Template 

This form will assist you with analyzing salary information you have obtained through salary surveys 
or other methods.  Fill out the appropriate information for your business and your competitors in 
order to compare and analyze differences in the various categories. 
 

Salary Comparison Sheet 1 

  Our Organization Local 1 Local 2 Industry 1 Industry 2 

Position Title 

               

 

          

 

          

 

          

 

          

 

Base Salary 

               

 

          

 

          

 

          

 

          

 

Benefits  (check if 
employer provides)           

Medical          

Dental          

Vision          

Life Insurance          

Other (specify)          

Stock Options 

               

 

          

 

          

 

          

 

          

 

Retirement 
Benefits 

               

 

          

 

          

 

          

 

          

 

Perks 

               

 

          

 

          

 

          

 

          

 

Additional Benefits 
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Salary Comparison Sheet 2 

  Our Organization Local 1 Local 2 Industry 1 Industry 2 

Position Title 

               

 

          

 

          

 

          

 

          

 

Base Salary 

               

 

          

 

          

 

          

 

          

 

Benefits  (check if 
employer provides)           

Medical          

Dental          

Vision          

Life Insurance          

 

Other (specify)          

Stock Options 

               

 

          

 

          

 

          

 

          

 

Retirement 
Benefits 

               

 

          

 

          

 

          

 

          

 

Perks 

               

 

          

 

          

 

          

 

          

 

Additional Benefits 
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4. Collect and protect confidential HR information 
 
HR professionals often work with personal information about employees, such as 
medical and financial records. This data is useful for developing important HR 
reports, but it isn't just data — it's private information. Your challenge is to use the 
data you need to keep your business practices efficient and competitive and still 
respect employee confidentiality. 
 
Note   You can create content with restricted permission using Information Rights 
Management only in Microsoft Office Professional Edition 2003, Microsoft Office 
Word 2003, Microsoft Office Excel 2003, and Microsoft Office PowerPoint 2003. 

You can create e-mail messages with restricted permission using Information Rights 
Management only in Microsoft Office Professional Edition 2003 and Microsoft Office 
Outlook 2003. 
Controlling how content is viewed and shared 
Information Rights Management (IRM) technology can help protect the 
confidentiality of employees' personal data by enabling the people who are 
compiling and sharing the information — HR professionals — to set rules that 
control how the information can be viewed, by whom, and for how long. It's easy to 
create confidential content in Microsoft Office Word, Microsoft Office Excel, or 
Microsoft Office PowerPoint® — and distribute it using Microsoft Office Outlook® 
2003 —  by following a few simple steps. 

You define permissions for files individually, so that each file is safeguarded 
appropriately for its content and audience. Recipients can open the document, 
workbook, or presentation as usual — but they can work with the content only 
according to the permissions you set. 

Set permissions for a file 

 1. Start Office Word 2003, Office Excel 2003, or Office PowerPoint 2003, and 
open or create a document, workbook, or presentation. 

 2. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 3. In the Permission dialog box, select the Restrict permission to this < 
file type > check box. 

 4. In the Read and Change boxes, type the names or e-mail addresses of 
people you want to give permission to. If you want to give all users 
permission, click Give all users Read access  to the right of the Read box, 
or click Give all users Change access to the right of the Change box.  

 5. Click OK , save your document, workbook, or presentation, and distribute to 
the people with permission. 

Tips 

 • You can also restrict permission for a document, workbook, or presentation 
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by clicking Permission  on the Standard toolbar  (toolbar: A bar with 
buttons and options that you use to carry out commands. To display a 
toolbar, press ALT and then SHIFT+F10.) . 

 • If you want to use a different user account to create content with restricted 
permission, point to Permission on the File menu, and then click Restrict 
Permission As . 

 • To use a custom permission policy  (permission policy: An approach to 
restricting permission for a given document, workbook, presentation, or 
message. The policy defines which Office features are available, which 
information can be accessed, and what level of editing is allowed.) that an 
administrator has created for people within your company, point to 
Permission on the File menu and then click a custom permission policy on 
the submenu. 

More permission options 

You can add and refine permission settings by clicking More Options in the 
Permission dialog box. Do any of the following: 

Set an expiration date for content 

 1. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 2. In the Permission dialog box, click More Options . 
 3. Under Additional permissions for users , select the This < file type > 

expires on check box, and then select an expiration date from the calendar. 
Include referral information 

 1. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 2. In the Permission dialog box, click More Options . 
 3. Under Additional settings , select the Users can request additional 

permissions from check box, and then enter a valid e-mail or Web 
address — for example, mailto:someone@example.com. Your e-mail address 
appears in the text box by default. 

Note   If you've previously selected the Remove personal information from file 
properties on save check box ( Tools menu, Options command, Security tab), 
and you've saved your document, workbook, or presentation after you've restricted 
permission for it, no referral address appears by default. 

Allow users to view content without Microsoft Office 2003 

 1. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 2. In the Permission dialog box, click More Options . 
 3. Under Additional settings , select the Allow users with earlier versions 

of Office to read with browsers supporting Information Rights 
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Management check box. 
Require users to connect to the Internet to open content with restricted permission 

 1. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 2. In the Permission dialog box, click More Options . 
 3. Under Additional settings , select the Require a connection to verify a 

user's permission check box. 
Change a user's access level 

 1. On the File menu, point to Permission , and then click Do Not Distribute 
. 

 2. In the Permission dialog box, click More Options . 
 3. In the list of users who have permission, click the user whose access level 

you want to change. 
 4. Under Access Level , point to the current access level for that user, click the 

arrow, and then select a new access level. 
Distributing protected files using Outlook 

Using IRM, you can create rules and policies that specify who can read messages. 
This helps to prevent sensitive e-mail messages from getting into the hands of 
people who shouldn't see them. You can also specify that recipients may not copy, 
paste, print, forward, or edit the information. You and the recipients of your 
messages can worry less about information leaks that can lead to negative 
perceptions among employees. 

If recipients don't have Outlook 2003 installed on their computers, they can 
download the Rights Management Add-on for Microsoft Internet Explorer or another 
program that supports content with restricted permission. 

Note    When you attach a Microsoft Office 2003 document to a message with 
restricted permission, you automatically restrict access to the document. If 
permission is already restricted for the attached document, the attachment retains 
its existing permission. 

The Permission button 

Use the Permission button  on the Outlook toolbar to restrict permission on an e-
mail message for specific recipients. Click Permission  again to remove restricted 
permission. Recipients can open and read an e-mail message with restricted 
permission just as they would a message that doesn't have restricted permission — 
but they can't forward, print, or copy the content. 

Message expiration 

You can set messages to expire so that they are unavailable or obsolete after a 
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certain date. To set an expiration date for a message: 

 1. On the Outlook toolbar, click the arrow next to Options , and on the drop-
down menu that appears, click Options . 

 2. In the Message Options dialog box, under Delivery options , select the 
Expires after check box, choose a date and time, and then click Close . 

When a message expires, the message header remains visible in Outlook folders 
with a line through the header text, but recipients cannot open or take any other 
actions on the message. 

You can set a message expiration date without restricting permission for a message. 
In this case, when the message expires the header still appears with a line through 
it, signaling that the message has expired or is no longer valid. However, because 
the content was not restricted, recipients can continue to open and work with the 
message. 

Permission policies 

E-mail administrators can add up to 20 custom permission policies to the 
Permission submenu of the File menu. These permission policies define who can 
read messages and what actions recipients can take with those messages. For 
example, an e-mail administrator might define a policy called "Company Benefits: 
Confidential" that specifies that a message using that policy can be opened only by 
people inside the company domain. 

Troubleshoot using IRM with Outlook 

I want a message with restricted permission to expire on a particular date for the 
message recipients, but I am worried that I won't be able to access the message 
after the expiration date. 

As the sender of a message with restricted permission, you can access the content 
after its expiration date. 
I was able to open an e-mail message with restricted permission previously, but 
now I can't. 
Permission to open the message may have expired. You might want to contact the 
sender to ask for the message to be sent again without an expiration date or with a 
new expiration date. 
I replied to an e-mail message with restricted permission, but the original message 
wasn't included. 
When you reply to a message with restricted permission, the message body of the 
original message isn't included in your reply message. Any attachments to the 
original message are also removed. However, when you forward a message, the 
original message is added as an attachment to the forwarded message. 
When I try to open an e-mail message I received, Microsoft Office Outlook 2003 
says I need to use a .NET Passport to access the message. 
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The sender of the message chose to restrict permission for the message by using a 
Microsoft Windows Rights Management server that uses Microsoft .NET Passport for 
authentication  (authentication: In a multiuser or network environment, the process 
of validating user logon information. A name and password are compared to an 
authorized list, and, if there is a match, access is granted with the level of 
permission specified.) . You must have an Information Rights Management (IRM) 
license in order to read the message. 
If you receive a message with restricted permission applied by the sender using 
.NET Passport for authentication, you must obtain a .NET Passport for the e-mail 
address the sender used to contact you. After you have obtained a .NET Passport 
for this e-mail address, you will be prompted to verify your credentials for the 
message when you open it. Then you will receive a Rights Management license, and 
you can read the message. 
I can't open an e-mail message with restricted permission when I am working 
offline. 
In some cases, e-mail messages with restricted permission require you to connect 
to the Internet to verify your credentials and confirm that you have been given 
permission to read the message. After you have verified your credentials for a 
document, workbook, or presentation for the first time, you will be able to open the 
message when you are working offline. 
An attachment I included in a message with restricted permission now has restricted 
permission, too. 
When you compose an e-mail message with restricted permission and include 
attachments, by default Microsoft Office 2003 documents, workbooks, and 
presentations that do not have restricted permission take on the permissions that 
you set for the message. If permission is already restricted for the attached file, it 
retains its existing permission. 
Attached files that do not support restricted permission can be opened by anyone 
who has permission to open the message. 
Viewing content with restricted permission 

Viewing content when Office 2003 is not available 

If you need to read or open content with restricted permission but don't have 
Office 2003 available on the computer you're using, you can download the Rights 
Management Add-on for Microsoft Internet Explorer or another program that 
supports content with restricted permission. 
Viewing your permissions in Word, Excel, and PowerPoint 
In Word, Excel, and PowerPoint, you can view the permissions given to you in the 
My Permission dialog box. (In the Shared Workspace task pane, click View my 
permission .) 
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5. Training and Development Managers 
 
Solve the return-on-investment puzzle 
 

Training is often defined as acquiring skills that improve performance. Today's 
training and development managers also know that success depends on consistently 
enhancing employee performance. Changes in technology, workplace diversity, and 
global markets have focused even more attention on training. According to the 
American Society of Training and Development (ASTD), companies in the United 
States spent $54.2 billion on training in 2003. 

Understandably, management wants to know the return on this enormous 
investment. When designing a training program, it's critical to determine a 
reasonable budget and then to convince management it's worth spending the 
money. You need to make a business case showing that the training dollars are 
justified by the potential return. 

Know the importance of ROI 

When a company is focused on keeping down expenses, it can be difficult to justify 
people programs, such as training, that cost significant amounts without showing a 
clear return. There's probably a limited pool of dollars out there, and you're 
competing with other budget requests and priorities. 

The more prepared you are to talk numbers — the language of business — the 
more likely you are to win approval for your budgets and programs. You also 
increase the odds that the human resources department will be seen as a valuable 
internal business partner. 

Define success up front 

Where does the training and development manager need to begin? Start 
investigating the return on investment (ROI) by identifying what success looks like. 
Answering the following questions helps: 

 • What strategic intent must the training address (for example, lack of a critical 
skill in the work force, or the need to build new skills to move in a new 
direction)? 

 • What should happen as a result of the training (for instance, what different 
behaviors that are of value to the business should be evident when trainees 
return to their jobs)? 

Quantify the return on investment 

After you confirm the desired success factors, you can develop a business case by 
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quantifying the dollar impact of meeting those factors. 

For example, if training will result in improved worker speed in a particular unit, the 
dollar impact can be quantified in terms of fewer worker hours needed to run that 
part of the business. Training might also have a measurable impact on overall 
employee head count, benefit costs, or even overtime expenditures. 

Let's say you conservatively estimate saving $2 million a year through a training 
program. If your training budget is considerably less than $2 million, you have made 
your business case. 

Develop a training budget 

Now, to determine the cost of the proposed training program, you need to consider 
these factors: 

 • Number of training sessions needed 
 • Number of participants 
 • Expenses for meeting space, meals, travel, and training materials 
 • Any fees for outside trainers or consultants either for preparing the training 

or for conducting the training, or both 
 • Overtime costs if other employees must work extra hours to cover for those 

employees in training 
 • Cost of lost productivity, including the time that participants spend at training 

sessions instead of at work, as well as staff time devoted to organizing the 
training 

Let's estimate a one-time cost of $200,000 for these elements of your proposed 
training program. Using the previous example, the training program has a return of 
$2 million, which is ten times higher than its cost. You can now bring a very 
compelling case to management that makes approval of your budget far more likely 
than if you had proposed spending $200,000 on training with an unknown return. 

Measure outcomes 

In order to find out whether your program had the desired result or whether the 
training needs fine-tuning, you need to measure what actually happens after 
training. When you define measures of success at the beginning of a training 
project, make sure that you also identify how that success is to be monitored and 
assessed. This process might include setting up ways to capture and track various 
business metrics. 

One way that can be useful is to compare groups or time periods, that is, compare 
employees without training with other employees who have received training, or 
compare employee performance before training with employee performance after 
training. Two common methods are: 



Information Systems Practical Guides – Re-arrange by. Riyadi 102 

 • Pretest/posttest   This method bases evaluation on the difference between 
participant measures taken before training and participant measures taken 
after training. 

 • Control group   This method bases evaluation on the difference between 
individuals who didn't receive training and those who participated in the 
program. 

Determine ROI on an `ongoing basis 

Training can be a big human capital investment, so it calls for a careful business 
case and attentive measuring of the impact on your business. As you go through 
these steps for each training issue, and as you compile the results, the process of 
determining the ROI and presenting your findings will become smoother and 
clearer. 

More information 

 • Training rollout initiative and plan 
 • What's my job? A guide to planning the best training programs 
 
About the author Mercer Human Resource Consulting assists clients in 
understanding, developing, implementing, and quantifying the effectiveness of their 
human resources programs and policies. Mercer Consulting also assists employers in 
creating measurable business results through their people. 

6. Use what-if scenarios to allocate training resources 
 
Microsoft Office Excel 2003 
Projecting expense totals under various scenarios can be an important part of 
allocating training resources. It's often helpful to project more than one set of 
values to see how they affect results. You can do this easily with what-if scenarios—
sets of input values that Office Excel can substitute automatically in your worksheet. 

What-if scenarios can help you answer questions such as: 

 • How would training only new employees affect training costs? 
 • What would my estimated total training expense be if I outsourced training? 
 • Which is more cost effective—training all employees at the same time or 

training one group at a time? 
You can create and save different scenarios on a worksheet and then switch among 
scenarios to view different results. You can also create a summary or PivotTable® 
list  (PivotTable list: A Microsoft Office Web Component used to create an 
interactive list that summarizes and analyzes data, such as database records, from 
various sources. Users can view the list in a Web browser and change its layout.) 
with the results of all your scenarios. 

Try it with a training budget analysis 
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To do a training budget analysis and see how changing the method, location, group 
of employees, or price affects your total training expense, you can define different 
values for these variables and then switch between scenarios to compare the 
results. 

The following illustration shows a current training budget analysis for this example. 

Training budget analysis: Current scenario 

 

Note   The scenario summary or report is easier to read if you name the cells or 
ranges of cells in your worksheet that contain variable data. In this example, you 
can name cell B2 Emp_to_train . 

How? 

 1. Select the cell, range of cells, or nonadjacent selections  (nonadjacent 
selection: A selection of two or more cells or ranges that don't touch each 
other. When plotting nonadjacent selections in a chart, make sure that the 
combined selections form a rectangular shape.) that you want to name. For 
example, click cell B2. 

 2. Click the Name box at the left end of the formula bar.   
  Name box  
 3. Type the name for the cells. For example, type Emp_to_train . 
 4. Press ENTER. 
Note   You cannot name a cell while you are changing the contents of the cell. 

Create scenarios 

 1. On the Tools menu, click Scenarios . 
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 2. Click Add .  
 3. In the Scenario name box, type a name for the scenario, such as Train 

New Employees Only . 
 4. In the Changing cells box, enter the references for the cells that you want 

to change, or hold down CTRL and click each cell. In this example, to try a 
scenario of training only 200 new employees, click cell B2.  Note   To 
preserve the original values for the changing cells, create a scenario that 
uses the original cell values before you create scenarios that change the 
values.  

 5. Under Protection , select the options you want. 
 6. Click OK . 
 7. In the Scenario Values dialog box, type the values you want for the 

changing cells. For example, for $B$2 (number of employees to train), type 
200 . 

 8. To create the scenario, click OK . 
 9. If you want to create more scenarios, click Add again, and then repeat the 

procedure. When you are finished creating scenarios, click OK , and then 
click Close in the Scenario Manager dialog box. 

Display a scenario 

 1. On the Tools menu, click Scenarios . 
 2. Select the scenario you want to see, and then click Show . The values for 

the scenario are automatically substituted in your worksheet, so you can see 
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how they affect results.   
Training budget analysis   

 
4. When you are finished, click Close . 

 
Create a scenario summary report or PivotTable report 

 1. On the Tools menu, click Scenarios . 
 2. Click Summary . 
 3. Click Scenario summary or Scenario PivotTable report .  

 
 4. In the Result cells box, enter the references to the cells that contain results 

that are changed by the scenarios. In this case, click cells B5 and B7 to see 
how the scenarios affect the total cost to train internally and the total cost to 
outsource training. Separate multiple references with commas. 

Note   You don't have to specify result cells to generate a scenario summary report, 
but you must enter them for a scenario PivotTable report  (PivotTable report: An 
interactive, crosstabulated Excel report that summarizes and analyzes data, such as 
database records, from various sources, including ones that are external to Excel.) . 

The scenario summary report displays the variables for each scenario and the result 
cells. 

Scenario summary 
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The PivotTable report displays the result cells for each scenario. You can use the 
drop-down arrows to choose the results you want to be displayed. 

PivotTable report 
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7. Plan a training Web site with help from Visio 
 

Developing a human resources training Web site can be an intimidating project. As 
with any complex task, you need to start with a plan. And in order for the plan to 
work, it needs to be well organized and logically laid out. 
How do you get started? How can you easily create a high-level design that enables 
you to collaborate with your colleagues and incorporate the best ideas into your 
Web site? 
Plan the design — design the plan 

Start with the Conceptual Web Site template in Microsoft Office Visio® Professional 
2003. Use the template to create a diagram of your training site, and inspire 
collaboration by helping everyone visualize the purpose, content, and structure of 
the site. 

This example walks you through a typical training Web site plan at a high level. You 
can use it as a guide to help you get started or change it to reflect your company's 
specific training needs and requirements. 

Example of a Web site plan using the Conceptual Web Site template 

 

Home page shape 

Form shape 

Web page shapes 

Box callout shape 

Create a conceptual Web site 
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 1. Start Visio. 
 2. On the File menu, point to New , point to Web Diagram , and then click 

Conceptual Web Site (Metric) or Conceptual Web Site (US units) . 
 3. On the Standard toolbar, click the connector  (connector: Any one-

dimensional (1-D) shape that can be glued between two shapes in a drawing 
to connect the shapes.) tool  . 

 4. Because most Web sites typically have a home page, start there. Drag the 
Home page shape onto the drawing page from Conceptual Web Site 
Shapes . 

 
 5. With the Home page shape selected, drag the Web page shape onto the 

drawing page. This can help convey the concept of users going from the 
home page to a new page on the training site. The shapes connect.  Note 
  Each new shape connects to the shape that is currently selected.     With 
one shape selected, drag another shape onto the page.   The two 
automatically connect.  

 6. Double-click the Web page shape that you just added to the drawing page 
and type Course Selection to describe the purpose of this page. 

 7. With the Course Selection shape selected, drag the Form shape onto the 
drawing page. This shape indicates that users will fill out a form. For 
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example, users might register for a course, or complete a form to help the 
HR department track who has taken which courses, and when. 

 8. Continue dragging shapes onto the drawing page and connecting them until 
you've completed your diagram. 

 9. If you want, you can annotate the diagram. How  
 1. From the Callouts stencil, drag a callout shape onto the drawing 

page. 
 2. Connect the callout shape to the shape with which the callout 

information is associated. How  Do one of the following:  
 ▪ Drag an end point  on the callout shape to a connection point  

on the shape with which the callout information is associated. 
 ▪ Drag an end point on the callout shape to the center of the 

shape with which the callout information is associated. A red 
outline indicates a proper connection.  

 3. Double-click the callout shape to enter text. You can also adjust the 
width of the callout text block by dragging the callout shape's selection 
handles . 

 10. After you have all the elements of your training site in place, you can align 
and organize the shapes in your diagram to fine-tune it. 

 11. Save your conceptual Web site plan. 
Collaborate and incorporate 

Now it's time to collaborate with your colleagues on the training Web site plan. You 
can easily do this from within your Visio diagram by sending it out in an e-mail 
message. 

 1. In Visio, open your saved Web site plan. 
 2. On the File menu, point to Send To , and then click Mail Recipient (as 

Attachment) . 
 3. A new e-mail message automatically opens with your Visio diagram attached. 

The Subject line has the file name for your diagram. You can edit this or you 
can send the message in this form by entering the recipients' e-mail 
addresses in the To line and clicking Send . In the body of the e-mail 
message, be sure to include a reminder to review the attached file. 

Incorporate any feedback into your Web site plan. With the plan completed, you're 
ready to move on to designing the site. 

Now, put the plan to work 

When you share your plan at an early stage, you encourage collaboration and 
inspire brainstorming sessions. Plus, you can easily ask for feedback on your plan 
while there's still time to consider everyone's ideas. With this kind of practical 
collaboration, you can be more confident that your new training Web site will be 
useful to everyone it's designed to serve. 
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PART 5. MARKETING 
 
1. Build high-impact Web sites and drive traffic to them 
 

In this day of advanced technology, one of the most important marketing tools you 
can have is a strong Web presence. Virtually every business must have a Web site 
as part of its marketing plan. But building a Web site is only half the job. "If you 
build it, they will come" might be true in the movies, but not on the Internet. You 
do, of course, need to design a terrific and easy-to-navigate Web site, but you must 
also drive traffic to your site. Deciding how you will drive traffic to your site is just 
as important as building the site. 

Building your Web site 

It isn't hard to develop a plan for your Web site if you follow some simple 
recommendations. When you design your Web site, make sure to include the 
following elements: 

 • Ease of use 
 • Consistent branding 
 • Must-have content 
Ease of use 

Web sites have been in existence long enough that people are used to seeing 
certain well-established conventions. This fact is particularly true of e-commerce 
sites. Much as they expect the layout of a grocery store to make sense, visitors to 
your site expect a site that is easy to use and to navigate. 

 • Common layout characteristics  Users expect the menus on the left of 
the page or along the top of the page. They also expect a Home button on 
every page. Accommodate these expectations. Your site needs to be creative 
and engaging, not challenging to use. 

 • Common terminology  Stick to established Web site menu terms such as 
"About Us," "Shopping Cart," and "FAQ." Navigating different Web sites 
should be like driving different cars. Aesthetics might differ, but the main 
controls are always in the same places. 

 • Less scrolling  Don't write more text than you can fit into one maximized 
window. Content that doesn't appear in the maximized window might never 
be seen. If it's not possible to limit the text to one screen, at least keep the 
most important content at the top of the page, above the "fold line." 

 • Three clicks to content  Regardless of where users are on your site, they 
should never be more than three mouse clicks away from where they want to 
be. It's a Web site, not a labyrinth. Do some usability testing, and simplify 
your site design wherever possible. 
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 • Keyword search feature  For a large Web site, the ability to search 
content based on keywords can help you adhere to the three-clicks rule. If 
your site has 40 or more pages, consider adding the keyword search feature. 

Consistent branding 

 • Look-and-feel  Be as consistent as possible with layout styles, color and 
font choices, and graphic elements (especially logo placement). The pages 
don't have to be identical as long as they look related. Make sure that the 
look-and-feel of your Web site is consistent with your other marketing 
materials, including your collateral, packaging, and promotional pieces. 

 • Messages and tone  The same rule for look-and-feel also holds true for 
written content. Keep your company and product messages consistent 
throughout the site and across all of your other communication vehicles. Try 
not to follow a hip and dynamic tone with a staid and grave tone— it can be 
disorienting to your audience. 

Must-have content 

 • Your business  One of the first things a user should see on your home page 
is your company name and description. This is your first chance to position 
yourself. Keep your company description as crisp and concise as possible. 

 • Catalog  Offer an easy-to-find and clear description of your products and 
services. If possible, include photos, videos, or animations. 

 • Pricing  List the prices wherever possible. In some cases (such as 
customized services), it's not possible; however, you might lose customers if 
you force them to call you unnecessarily. 

 • Sales purchasing  Your products should be the easiest thing to do on your 
site. "Purchase," "Shopping Cart," and "Check Out" are recognized terms that 
should always be just a click away. 

 • Contact us  Make it easy for users to contact you and to get additional 
information. Offer as much contact information as appropriate. You might 
need to vary your contact information by country, region, or department (for 
example, sales, customer service, or human resources). 

 • Frequently asked questions  Many users instinctively head to the FAQ 
page to get information about everything from special promotions and pricing 
details to shipping and return policies. Provide your customers with this 
information in straightforward, easy-to-follow language. 

 • Industry recognition  Prominently post press articles, press releases, 
customer success stories, and industry awards. This information builds 
credibility and keeps potential customers moving through the sales process. 

Driving traffic to your site 

After you have built your site, driving traffic to your Web site needs to be an 
ongoing process. There is much to do before and during the launch of your Web 
site, but it's also important to routinely assess how easy your company is to find on 
the Web after you launch your site. You can take several steps to ensure that 
customers can find you on the Web. 
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Choose a domain name 

Ideally, your domain name (for example, msn.com, slate.com) needs be short, easy 
to spell, and easy to remember. You can use any one of a number of companies to 
reserve a domain name, and they all provide tools for determining whether a 
domain name is available or already taken. 

Get listed on search engines 

Search engines are a vital way for customers to find your site, so your first priority is 
to get your Web site listed on search engines such as MSN®. The following are the 
two ways to get listed: 

 • List your site for free  You can get your Web site listed for free on most 
major search engines by waiting for their Web crawlers to find your site, but 
that can take several months. 

 • List your site for a fee  If you want your Web site listed in just a few days, 
you can pay each search engine company a nominal fee to list your site. 

Improve your search results 

Just because your site is listed doesn't mean it will rank very highly in the search 
results. If you want search engines to rank your Web site higher in the results list, 
you need to do some site optimization. Site optimization strategies include: 

 • Deciding where and how often keywords appear on the home page of your 
Web site. The closer a keyword is to the top of the page, the better, 
especially if you can put keywords in the HTML title tag and in the main 
heading of the page. 

 • Choosing keywords that reflect how people might search for your site. 
Keywords need to be phrases at least two words long—  for example, 
"engineering software." The word "software" by itself is not specific enough. 

 • Including the right keywords in your Web site's meta tags so that you can 
improve your site's rank in search results. 

 • Getting other relevant sites (including search engines) to link to your site. 
Need further help? Marketing and Web design agencies can help you optimize your 
site's ranking in search results. 

Pay for placement 

Most of the large search engine companies allow you to pay for priority placement 
in their search results. This is ideal for companies that want to increase their 
visibility quickly. A variety of service terms is available. The higher your placement, 
the more you pay. 

Before you decide to pay for placement, use the search engines to search for your 
own Web site to determine whether your placement already meets your needs. 
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Promote your Web site 

To promote your Web site, try using the following strategies: 

 • Plaster your Web address on every piece of communication you 
generate  Put your Web address on everything from E-mail signatures to 
business cards to press releases to answering machine greetings. 

 • Link to and from other sites  Look for opportunities to have other Web 
sites link to your Web site. The higher the other site's traffic, the better. 
Linking is often a reciprocal arrangement. But don't just link for the sake of 
linking. Stay focused on driving the right kind of traffic— traffic that's 
relevant to your business. 

Learning from other Web sites 

When you design your Web site, remember that it's not necessary to reinvent the 
wheel! As you set out to create or update your Web presence, borrow ideas from 
other sites that you like. Try to conform to established design conventions. 
Following these important pointers can save you time and money and prevent 
headaches for your users. 

About the author  Cindy Kennaugh is President of On The Mark, a Silicon Valley–
based consulting firm specializing in all aspects of business-to-business marketing in 
the high-technology industry. 
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2. Establish a Web presence with Publisher 
 
Microsoft® Office Publisher 2003/2007 
 
The Web has opened up a new channel for advertising and contact that has become 
as established as the phone book. As a result, many businesses, large and small, 
have Internet sites on the World Wide Web. 

If you've put off creating a Web site for your own business because of time or 
technical concerns, you don't have to wait any longer. You can quickly and 
inexpensively establish a Web presence using one of the Web Site Wizards in 
Publisher 2003. 

 

The Web Site Wizards create Web pages for you. You can use the Web Site Options 
task pane to design and customize your pages. 

Plan your Web site No wizard, however straightforward and simple to use, can make 
up for a lack of planning. Before you jump in to Publisher, take the time to think 
about what you want your Web site to accomplish. Who are you trying to reach with 
your Web site? How will you keep them coming back? Is your site's intention simply 
to publicize your business or do you want to use it to actually sell your products or 
services? By answering questions like these in advance, you will be able to make the 
most out of the features the Web Site Wizards offer. 

Choose a wizard 
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Publisher includes four Web Site Wizards. The wizard you use depends entirely upon 
your site goals. 

3-page Web Site 

If you just want to get a basic site created that you know you'll add to in the future, 
this is the best wizard to use. Your site will include three pages, a Home page, 
About Us, and Contact Us. 

Product Sales 

Do you want to advertise and sell products from your site? If so, this is the wizard 
for you. In addition to the three basic pages (Home, About Us, Contact Us), the 
wizard creates a page where products are listed and also a detailed page for each 
product. 

Professional Services 

Does your organization provide services? This wizard creates the three basic pages 
(Home, About Us, Contact Us) for you, as well as a page where your services are 
listed, a detailed page for each service, and a project or client page, where you can 
list on-going and completed projects or provide client testimonials. 

Easy Web Site Builder 

Use this wizard if you want more choices up front about what types of pages your 
site will include. For example, you can add a calendar or schedule, employee 
information, links to other Web sites, and more. 

Tip   No matter which Wizard you use initially to create your site, you can always 
add new pages and functionality later. 

Create your site 

When you use one of the Web Site Wizards to create your Web site, the pages are 
created for you. All you have to do, after you make some design and color 
decisions, is replace the placeholder information on the pages with information 
relevant to your business. Before you publish the Web site, be sure to preview it 
and test all the links and content thoroughly. 

To create a Web site using a Web site Wizard 

 1. Start Publisher. In the New Publication task pane, click Web Sites and E-
mail, click Web Sites, and then click the name of the Wizard you want to 
use. 

 2. On the right, click the Web site design you want. 
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 3. If you are using the Easy Web Site Builder Wizard, select the options that 
describe what you want you do with your site, and then click OK. 

 4. The Personal Information dialog box may open. If you want to create a 
set of contact information, such as organization name and address, that 
Publisher can add automatically to all publications you create, fill in that 
information now, and then click OK. Filling in the information once now saves 
you from having to type your return address or contact information each time 
you start a new publication. If you don't want to fill in any information now 
but might want to the next time you start a new publication, click Cancel. If 
you don't want this dialog box to open when you start new publications, 
select Never show this dialog when starting a new publication. You 
can always open the Personal Information dialog again by clicking 
Personal Information on the Edit menu. 

 5. In the Web Site Options task pane on the left, under Navigation bar, 
click the navigation bar style that you want for the pages. 

 6. Toward the top of the task pane, click Page Content. Under Layout, click 
the layout that you want for the pages. 

 7. If you want to use a different color scheme or font scheme on your site, click 
Color Schemes or Font Schemes toward the top of the task pane, and 
then choose the scheme you want. 

 8. Replace the placeholder text and pictures on the Web site pages with your 
own content. 

 9. To preview and test your Web site in a browser, on the File menu, click Web 
Page Preview. Use the navigation bar to move between pages. 

 10. On the File menu, click Save As to name and save your Web site 
publication. 

Note   Information about how to publish your Web site is available in the topic, 
Publish a Web site, listed under See also at the top left of this page. 

Modify your site 

After you create and publish your Web site, you're bound to get new ideas from 
employees and customers about how the site can work more effectively. You can 
easily add new pages and functionality to an existing site, and adjust the design. 
For example, you can add an FAQ or News Article page. Or, you can include an 
order, response, or sign-up form. You can also add blank pages that you can design 
yourself. 

To modify your Web site 

 1. Open your Web site publication. If you don't see the Web Site Options task 
pane, on the View menu, click Task Pane. 

 2. To add a new page, under Add to your Web site, click Insert a page. 
Choose the type of page you want, and then click OK. Tip   If you want to 
add several pages at once that duplicate the current page, are blank, or have 
only one text box on each page, click More at the bottom of the Insert 
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Web Page dialog box. 
 3. To add a page or a series of pages related to a specific function you want the 

Web site to perform (for example, sell products or describe services), under 
Add to your Web site, click Add functionality. Choose the function you 
want, and then click OK 

 4. To change the navigation bar style for the pages, under Navigation bar, 
click the style you want. 

 5. To change the layout for any page, under Layout, choose the layout you 
want. 

 
 
3. Marketing Researcher 
 
Find the right primary market research technique 
 
Those in favor insist that hearing multilayered, interactive discussions from real 
customers still galvanizes a sales force or inspires marketing messages. "Because of 
the group dynamic, focus groups provide a great opportunity for rich feedback in a 
relatively short period of time," says Karen Leland, co-author of "Customer Service 
for Dummies." 

Naysayers argue that focus groups have outlived their usefulness because they 
uncover very little new or useful information. "Respondents have been trained to tell 
us what they think we want to hear, to analyze our 'strategy' or our 'target 
segment,'" says Leeann Leahy, director of account planning at Margeotes Fertitta ad 
agency in New York. 

So where's the truth? Between the extremes, as is usual. 

 
This is no ordinary box. This is like an ad agency in a box. 
How to avoid mistakes 

When setting up focus groups, concentrate on these steps: 
1. 
Determine your goals and objectives. Analyze what you want from the 
experience. Narrow your objectives to a concise written list so the facilitator can 
"focus" the group whenever they wander off the topic. With help from the 
facilitator, work on your discussion questions and follow-up points before recruiting. 
These should be open-ended queries that invite comments. 
Marketing gurus say focus groups are particularly useful when you are: 
 • Introducing a new product or new concept 
 • Positioning products or messages 
 • Managing change, in or outside the company 
 • Testing communications 
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 • Promoting or creating a brand 
 • Evaluating customer sentiment 
For example, a recent focus group for a retailer revealed that existing customers 
were annoyed that new customers were receiving incentives while loyal customers 
were not, according to Bette Price, management consultant and co-author of "True 
Leaders." Says Price: "This is an important issue to know about because the 
research all shows that it costs a minimum of five times more to attract a new 
customer than to keep an existing, loyal one."   

2. Do rigorous recruiting and screening. "The term 'focus group' has been 
diluted a great deal, with some thinking it's just a conversation," says David Shank, 
an Indianapolis publicist. But herding some executives into a conference room for a 
group gripe won't tell you much. 
Instead, rely on a professional and detailed screener who can gather a truly 
representative sample of the population you're studying. If your target includes men 
aged 20-35, then you need many of those male participants in the group. 
"Allow enough time for recruiting and make sure the budget allows flexibility," 
suggests Bonnie Ulman at The Haystack Group, an Atlanta market researcher. 
Encourage participation by offering an incentive, be it a free sample, a discount 
certificate or money. Cash awards run $25 to $150 per person, depending on your 
target's status. It's also customary to serve snacks or sandwiches as a way to warm 
up the group.    
3. Don't cheap out on the facilitator. Trained focus-group moderators are worth 
the money they charge. They know how to pose questions that elicit responses. 
They can synthesize the discussion, playing back opinions to tap specifics behind 
generalizations. They draw out shy or disengaged participants. And lots more. The 
biggest mistake clients can make is to be their own facilitator, says Nancy Haynes at 
Collins, Haynes & Lully Advertising in Charlotte, N.C. She says, "Two places one 
should never try to cut corners: a focus group facilitator and a surgeon!"  
  
4. Don't expect hard data. Focus groups are categorized as soft or qualitative 
market research, in contrast to quantitative research that yields hard numbers or 
statistics. The point is to create a group dynamic. You're paying to get a visceral 
sense of what a sample of your defined customers think and feel. When successful, 
focus groups uncover motivations for your target's choices and decisions, which is 
obviously enormously helpful. But you don't get statistical charts -- just an 
emotional snapshot. 
  
5. Do listen to the "loudmouth." Invariably, every focus group includes a 
participant who tends to take over the discussion. This is another reason to have a 
trained facilitator. Moderators graciously get him or her to back off, giving other 
participants a chance. Nevertheless, this particular group dynamic is also valuable. 
"A common criticism of focus groups is that a dominant participant may influence 
others," says Elaine Ralls, at HMI, an integrated marketing firm in Tempe, Ariz. But 
"it should be recognized that the same influential patterns occur in the 
marketplace." You gain helpful insights by observing what the "influencers" in the 
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room do or say. 
  
6. Do remain flexible. The advantage of traditional focus groups over those 
mounted online or via phone conferences is that you can shift direction quickly. If 
the group alights on a point or area you want to explore, the facilitator can follow 
up. Usually, there's a phone in the room or a prearranged signal to contact the 
facilitator. She or he then leaves the room, briefly confers with you and returns to 
steer the discussion as you direct. 
In summary, for focus groups to be effective, you must plan a solid strategy, hone 
your questions and objectives, and hire an experienced, veteran facilitator. 
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